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C H A P T E R

INTRODUCTION
The following major topics are discussed in this chapter:
• “About this Guide” on page 1
• “nView vs. NVIDIA Display Properties” on page 2
• “Why do I need Desktop Management?” on page 3
• “About nView Desktop Manager” on page 3
• “Key Terms and Concepts” on page 8
• “Features and Benefits” on page 11
• “Application Compatibility” on page 16
• “System Requirements and Support” on page 17

About this Guide
This User’s Guide is addressed to users of the NVIDIA® nView™ Desktop 
Manager, which is a desktop and application management tool that runs on 
Windows operating systems. 

Other Related Documentation
• If you are primarily using the NVIDIA workstation products, i.e., graphics 

cards based on the Quadro® through Quadro®4 series of NVIDIA GPUs 
(graphics processing units), see the “Quadro Workstation User’s Guide”.
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• For details on using the nView Desktop Manager application component of 
the NVIDIA display drivers, see the “nView Desktop Manager User’s Guide 
(Driver Release 40)”.

• The document titled “NVIDIA Drivers for Windows: Release 40 Notes” 
enables add-in-card (AIC) producers and original equipment manufacturers 
(OEMs) to monitor performance improvements and bug fixes in the driver. 

nView vs. NVIDIA Display Properties
The NVIDIA Display Driver software includes two software components: 
nView and NVIDIA Display Properties.
• nView represents a collection of multi-display technologies encompassing 

driver support, multi-display GPU architecture, and desktop management 
support. The primary nView component is the Desktop Manager, which is a 
user-level application utility that focuses on making you more productive 
when working on your Windows desktop.
Note: Desktop Manager is now a separate item on the Windows Control 

Panel group (Figure 1.1). You can click this item to access the nView 
Desktop Manager properties panel.

Figure 1.1 Windows 2000 Control Panel with nView Desktop Manager Option

• NVIDIA Display Properties refers to the NVIDIA Windows Control Panel-
based user interface, which you can access from the Windows Display 
Properties > Settings > Advanced option and configure the advanced 
display properties of the current release of the NVIDIA Windows Display 
Driver software.

Note: The NVIDIA Display Properties also includes the nView Display Mode 
option, which lets you configure multi-display support for Clone and/or 
Span modes if you are using an NVIDIA GPU-based card that supports 
N V I D I A  C o r p o r a t i o n 2
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multiple displays. See Table 1.1 Supported NVIDIA Products and also 
the NVIDIA Display Properties User’s Guide.

Why do I need Desktop Management?
As users run more and more applications and process even more information, 
their screen sizes are getting larger and larger. Larger screen area simply makes 
users more productive. 
One of the more cost effective and common ways of increasing screen area is to 
use multiple displays and/or multiple desktops (multiple desktops can be 
created in a single-display setup), which allow you to place your applications on 
multiple displays and desktops having ready and immediate access to the 
information they contain.
While large screens and multiple displays and desktops are a great way of 
increasing your visible work area, these larger desktops start becoming more 
difficult to manage. Once simple operations such as finding your mouse cursor 
or even a window can become very time-consuming when you have to hunt 
through several screens.
In addition, using multiple displays results in additional issues such as the 
screen split between two displays – windows that are placed on this screen split 
are extremely difficult to read. So, while larger desktop areas promise to 
dramatically increase your productivity, there are user interface issues that can 
make it difficult to use at times.
A “desktop manager” manages your large desktop and takes care of many of the 
user interface issues that result from moving to a larger desktop area. You can 
think of a desktop manager as being an extension of the windows user interface 
tailored for large desktops.

About nView Desktop Manager
nView Desktop Manager supports both single-display and multi-display 
configurations running with single-display, multi-display, or multiple graphics 
cards based on NVIDIA GPUs. 

Multi-Display Support
The Desktop Manager feature set primarily focuses on multi-display use by 
workstation users in finance, corporate, digital content creation (DCC) and 
similar organizations as well as in the mobile (laptop) markets. Therefore, to 
take advantage of the full feature set of the Desktop Manager, you need a multi-
3 N V I D I A  C o r p o r a t i o n
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display configuration. With multiple displays, you can view a single application 
as a large window stretching across several displays, or you can display 
different applications on each monitor. Using a multi-display configuration is an 
efficient and cost-effective way to increase the size of your computer display 
area, commonly called the “desktop”.

Single-Display Support
Desktop Manager is designed for broad applications across the wide range of 
NVIDIA product lines and markets. Therefore, single-display users can also 
take advantage of many of its features. Although you cannot use multi-display 
features in a single-display configuration, you can create multiple desktops and 
use hot keys, NVKeystone™, and windows effects.

nView Desktop Manager Properties Panel
The nView Desktop Manager properties panel is independent of the properties 
that are accessed through the Windows Display Properties Settings panel. The 
nView Desktop Manager properties panel contains separate tabs, as shown in 
Figure 1.2.
Once Desktop Manager is enabled, the Desktop Manager properties panel is 
easily accessible from a variety of areas on your desktop. For example, it is 
available from:
• the Windows Control Panel group
• the properties menu when you right click on your desktop 
• the Media Center taskbar icon
When you open the nView Desktop Manager properties panel, the default Info 
tab is displayed. The Profile, Windows, Effects, Zoom, and Hot Keys tabs 
allow you to configure key Desktop Manager features as described in “Features 
and Benefits” on page 11. 
If you want to exercise even more control over your Windows desktop, you can 
choose to enable Show Advanced nView Controls. Clicking this option on the 
Info panel (Figure 1.3) displays additional tabs including Desktops, User 
Interface, Applications, and Tools. 
Note: See individual chapters in this guide for details on using the features on 

these tabbed panels.
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Figure 1.2 nView Desktop Manager Properties: Info Panel (default)

Figure 1.3 nVIew Desktop Manager Properties: Info Panel After Enabling Desktop 
Manager 

nView Desktop Manager
properties panel

Info tab

Tabs: Info, Profiles, Windows,
Effects, Zoom, and Hot Keys
5 N V I D I A  C o r p o r a t i o n



N V I D I A  n V i e w  D e s k t o p  M a n a g e r  U s e r ’ s  G u i d e

nViewGuide.book  Page 6  Wednesday, October 30, 2002  8:55 PM
Figure 1.4 nVIew Desktop Manager Properties: Info Panel After Enabling Desktop 
Manager Advanced Options 

New Features and Enhancements 

Feature Enhancements
The following features have been enhanced in the new version of NVIDIA 
nView Desktop Manager:
• Operating System Support

NVIDIA nView supports Windows NT 4.0, Windows 9x/Me, and Windows 
2000/XP.

• Profile Feature
Display Modes are now saved to and loaded from each profile

• Multiple Desktop Support: The following new features have been added to 
the NVIDIA nView multiple desktop functionality:
• Support for multi-monitor wallpaper selection. (See “Properties: Changing 

Wallpaper and Desktop Icons” on page 144.)
• Graphical display in explorer shell extension

Advanced Option tabs:
User Interface, Tools,
Applications, and Desktops
N V I D I A  C o r p o r a t i o n 6



C h a p t e r  1 I n t r o d u c t i o n

nViewGuide.book  Page 7  Wednesday, October 30, 2002  8:55 PM
• Support for icons to represent desktops. (“Properties: Changing Wallpaper 
and Desktop Icons” on page 144.)

• Support for arbitrary positioning of windows on the desktops
• Zoom Support 

- New fixed-frame zoom (See “Fixed Frame” on page 105.)
- Bi-directional zoom editing capability (See “Enable Bi-Directional 
Editing” on page 106.)

New Features
The following are features that have been added to the new version of NVIDIA 
nView Desktop Manager:
• nView Task Switcher

When enabled, nView adds a desktop switcher in addition to the standard 
application tab switcher. By default, this additional “switch desktop” 
functionality is accessed through a Alt-~ keystroke combination which you 
can change through options in the Hot Keys panel. See “Enable nView Task 
Switcher” on page 125.

• Color-Keyed Windows
This feature lets you use to color key windows for easy identification when 
activating them on the desktop. See “Enable Windows Color Keying” on 
page 98.

• NVKeystone 
This feature allows real-time image correction on portable projectors and 
heads-up displays.1

For example, NVKeystone can be set to compensate for keystoning effects 
on your windows display, allowing you to fix distorted projection images. 
This feature is primarily for laptop (mobile) computers.
See “Accessing NVKeystone” on page 160.

• Taskbar and Menu Transparency. See “Using Effects” on page 95.
• New window actions, such as‚ Collapse 
• New applications settings, including a full set of application launch and 

disable settings. See “Managing Applications: For Advanced Users” on 
page 165.
7 N V I D I A  C o r p o r a t i o n
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1 NVKeystone is not supported on graphics cards based on the TNT, TNT2 or Vanta product 
families.

Key Terms and Concepts
Desktop Manager can manage and control many items on your desktop. 
Generally, it operates on two types of desktop objects – “windows” or 
“applications”.

application
An application (or program) can have any number of windows. Some 
applications have only a single window such as Calculator or Notepad. Other 
applications can have many windows such as Outlook where you can open 
several E-mail windows, have your Inbox open, open calendars, etc.
Desktop Manager can perform operations on applications as well as windows. 
In the case of applications, the operation is performed on every window that is 
part of that application. 
If you run multiple copies of an application, any operation you perform on a 
copy of the application will apply to every copy of the application that is 
running. 

child window
A child window refers to any “sub” window of the main or “parent” application 
window. For example, in the Microsoft Excel application, you can open several 
worksheets at once inside the main Excel window. Each worksheet is a child 
window of Excel.

Control Panel
Refers to the Windows Control Panel group, which you can access by clicking 
Start > Settings > Control Panel from the Windows desktop. NVIDIA nView 
Desktop Manager is a clickable icon in this group of icons. When you double-
click this icon, the nView Desktop Manager properties panel (shown in Figure 
1.2) appears.
Note: The nView Desktop Manager properties panel in earlier revisions of the 

this document was called the nView Desktop Manager control panel.

desktop
A “desktop” is the on-screen work area on which windows, icons, menus, and 
dialog boxes appear. You can create multiple desktops on single-display 
systems or multi-display systems, thereby increasing your work area.
N V I D I A  C o r p o r a t i o n 8
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dialog box
Dialog boxes are user-input windows that contain command (buttons) and 
various kinds of options through which you can carry out a particular command 
or task. For example, in a Windows application “Save As” dialog box, you must 
indicate the folder to contain the document to be saved and the name of that 
document when saving it.
Also see the definition of “modal dialog box” and “modeless dialog box” on this 
page.

dual-card configuration
A setup where two or more display devices are connected to two NVIDIA GPU-
based graphics cards installed in the computer.

GPU
graphics processing unit (GPU). NVIDIA graphics chip products are called 
GPUs. Supported NVIDIA GPUs are listed in “Hardware: Supported NVIDIA 
Products” on page 19.

keystoning 
Keystoning describes the distortion that occurs when your display is projected 
onto a curved surface or is projected at an oblique angle to a surface. 
For example, if a projector were used to project an image on a flat wall, the 
projector would ideally be set up to point straight at the wall. If you then angled 
the projector right or left, you would see the image on the wall distort. 
As a second example, if you projected your image onto a curved wall instead of 
a flat wall, you would also see your image distorted. This type of distortion is 
called “keystoning.” 
The nView Desktop Manager feature called NVKeystone that can compensate 
for this effect. For details on using this feature, see “Using Tools Options” on 
page 157.

modal dialog box 
A dialog box that puts you in the state or “mode” of being able to work only in 
the dialog box. You cannot make a modal dialog box inactive. It can only be 
closed by clicking one of its buttons.

modeless dialog box 
A dialog box that resembles a document window without a collapse box. You 
can make a modeless dialog box inactive and active again without closing it.
9 N V I D I A  C o r p o r a t i o n
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multiple-card configuration
A setup where two or more display devices are connected to two (or more) 
NVIDIA GPU-based graphics cards in the computer.

multi-display configuration
A setup where two or more display devices are connected to either a multi-
display NVIDIA GPU-based graphics card in the computer; or two (or more) 
NVIDIA GPU-based graphics cards in the computer.

parent window
A “parent” window refers to the “main” default launch window that you see 
when an application opens. For example, in the Microsoft Outlook application, 
the main window is your “Inbox”, since that’s the first window that launches 
when you open Outlook.

properties panel
NVIDIA nView Desktop Manager is a clickable icon in the Windows Control 
Panel group of icons. When you click this icon, the nView Desktop Manager 
properties panel (shown in Figure 1.2) appears.
Note: The nView Desktop Manager properties panel in earlier revisions of the 

this document was called the nView Desktop Manager control panel.

single-display configuration
A setup where only one display device is connected to the NVIDIA GPU-based 
graphics card in your computer.

skin
A file that customizes the “look and feel” of the Windows user interface.

tab
Individual Desktop Manager “tabs” (i.e., Profiles, Effects, Windows, Hot Keys, 
and Desktops) are available from the nView Desktop Manager properties panel.

window
A “window” is any independent window on your desktop. Applications such as 
Outlook or Explorer may have several windows, which are all part of the same 
application. Windows can be dragged around the screen, opened and closed, and 
resized. Desktop Manager allows you to do even more with windows such as 
make them transparent or force them always to be on top of other windows.
N V I D I A  C o r p o r a t i o n 10
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window class
(For advanced users only.) 
Every type of window shown on your desktop has what is called a “window 
class” that describes the type of window it is. These window classes are shared 
between different applications. Normally, this window class information is 
hidden from users as there is no need to know it. nView Desktop Manager, 
however, allows you to perform operations on window classes as well as 
applications. This allows nView Desktop Manager to be set up to treat certain 
types or classes of windows differently. Because window classes are shared 
between applications, by individually configuring a particular window class, 
you can modify behavior for all applications that use windows of that class.
For example, all dialog boxes have a window class of #32770. nView Desktop 
Manager can be set up to disable transparency for all #32770 class windows. 
The effect of this would be that no dialog boxes from any application would 
ever be transparent. 
For details on using this feature, see “Managing Applications: For Advanced 
Users” on page 165.

Features and Benefits
The Desktop Manager application engine consists of several features that 
manage windows, desktops, displays, applications, hot keys, and window 
effects. This section provides an overview of the key functions in terms of these 
features.
For details on these features and how to use them, refer to individual chapters in 
this guide.
Note: A few features may be restricted to users with System Administrator 

access privileges under Windows XP/2000 and Windows NT 4 and will 
be noted as such, where applicable in this guide.

Windows Management 
The windows management features are available on the Windows page (Figure 
1.2) on the nView Desktop Manager properties panel. 
Multi-display features allow you to do the following tasks:
• Configure your system to prevent windows from stretching across (spanning) 

displays.
• Configure where dialog boxes pop up on your desktop. You can have them 

appear centered on the display device on which your cursor is displayed.
11 N V I D I A  C o r p o r a t i o n
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• Add a custom maximize option to your windows. Tis option lets you 
maximize windows to a single display device (monitor) or to the entire 
desktop.

Other features allow you to do the following tasks:
• Extend the Windows user interface with new and powerful window controls.
• Extend the style of every window in your system. Using Desktop Manager, 

you can turn windows transparent or force them to always be on top of other 
windows.

• Extend the system menu of every window in your system with the style 
options above plus options to move windows to different desktops and 
displays.

• When using multiple desktops, set a window to be visible on every desktop 
for those windows you always want to see.

For complete details on using Windows Management features, see “Managing 
Windows” on page 90.

Desktops Management
Using the Desktops settings on your nView Desktop Manager properties panel, 
you can do the following tasks:
• Create up to 32 different desktops, each with its own background. 
• Open and move applications between different desktops and switch between 

desktops with a single keystroke
• Use multiple desktops to reduce the clutter on your desktop – you can group 

similar applications on different desktops and quickly switch between them.
• Show your desktops, including a graphical birds-eye view of each desktop 

within Windows Explorer.
• Manage your desktop in several ways to suite your style. You can access and, 

therefore, switch between desktops using various methods, including:
• Using hot keys
• Right clicking on any desktop
• Your folder tree in Windows Explorer
• Options from a Media Center icon on your Windows taskbar
• A desktop toolbar that can be floating or docked to the taskbar
• NV Task-Switcher
N V I D I A  C o r p o r a t i o n 12
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For complete details on using Desktops Management features, see “Managing 
Desktops” on page 138.

Application Management 
The application management functionality of Desktop Manager is available 
from several Desktop Manager tabs (“Using the User Interface Options” on 
page 123, “Managing Windows” on page 90, and “Managing Applications: For 
Advanced Users” on page 165). Using these features, you can do the following 
tasks:
• Perform operations on entire applications, such as moving an entire 

application to a desktop or to a monitor.
• Set up your Window Manager to function differently for different 

applications. For example, you may never want a Word window to span 
multiple displays; however, you may want a spreadsheet, such as Excel 
windows, to span multiple displays so you can see all the columns. 

• Save all your customized Desktop Manager settings for an application when 
you close it and restore them when you reopen the application. 
For example, if you enable the Individual Settings feature, the application 
manager can remember if you closed the Microsoft Word application on your 
second desktop and whether or not the Word window was transparent when 
you closed it. When you re-open Word, it automatically opens on your 
second desktop and have transparency enabled. 
Using this feature, you can also specify that Word always launches on a 
specific desktop with a specific state (such as Transparent or Always on 
top).

• Extend certain applications. While every window under Desktop Manager 
has an extended menu giving options such as transparency or desktop 
visibility, certain applications such as Internet Explorer 5.0 have additional 
nView menu options allowing you to be more productive with the 
application.

Profiles Management
You can quickly set up the Desktop Manager using the Profiles page from the 
nView Desktop Manager properties panel.
Note: Under Windows XP/2000 and Windows NT 4.0, several profile-related 

options may be restricted to users with System Administrator access 
privileges
13 N V I D I A  C o r p o r a t i o n
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Desktop Manager lets you save all of its settings including desktop, window, 
and application settings to a data file called a “profile”. This profile includes all 
of your Desktop Manager settings – even individual settings for your 
applications. You can then reload your profile on any computer at any point in 
the future. If you switch computers, upgrade your operating system, or are 
configuring an office, you can simply save all your settings to a profile and then 
load those settings on any computer that you want.
In addition to nView desktop management settings, Profiles can also save and 
restore your display mode information as well. This includes the number and 
position of enabled monitors, each monitor’s refresh rate, resolution, color 
depth and more. When you load the profile, this information will be restored. 
Note that unlike desktop management settings, display mode settings are 
dependent upon the hardware in your machine and thus may not work when 
transferred between machines. For example, if a profile was saved with display 
mode information on a computer that had four displays connected and is then 
copied to a computer that has only two displays connected, then loading this 
profile on the two-display computer will not restore the display mode because 
the physical hardware (i.e., four displays) does not exist on the computer.
You can save as many profiles as you like for different operating modes. If you 
use a laptop, you may want Desktop Manager to be set up differently when you 
are docked than when you are not docked. Using profiles, you can create a 
docked and undocked profile and switch between them. You can even set up a 
hot key to load a profile so you can switch with a single keystroke.
Desktop Manager comes with several pre-defined profiles to get you started 
quickly. These profiles contain the basic settings for different user levels and 
industries. You can start with one of these pre-defined profiles and tailor it to 
your own needs.
Profiles management features are discussed in “Working With Profiles” on 
page 84

User Interface
Using the User Interface settings, you can customize the user interface that 
nView Desktop Manager uses on your desktop. This includes turning on and off 
title bar buttons for your application windows, setting up the nView options 
menu, and enabling nView informational menus. You can also do the following:
• Turn on and off a title bar button allowing access to nView features from 

each window on your desktop.
• Turn on and off a title bar button that adds a new type of windows 

minimization feature to your desktop – collapsing the window to a title bar.
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• Turn on and off a feature that shows your multiple desktops inside Windows 
Explorer.

• Turn on and off several notification message options.
The User Interface features are discussed in “Using the User Interface Options” 
on page 123. 

Tools
For details on using the Tools features, see “Using Tools Options” on page 157.
The nView Desktop Manager toolbox includes several utilities designed to 
solve specific user problems. You can use tools, such as “NVKeystone” and 
“flat panel calibration” to improve your display quality. Utilities include anti-
keystoning support and flat panel monitor calibration screens are designed to 
improve windows multi-display features.
The Tools panel contains the following key features:
• NVKeystone can be set to compensate for keystoning effects on your 

windows display, allowing you to fix distorted projection images. This 
feature is primarily for laptop (mobile) computers.

• Analog flat panel calibration displays a screen on your display optimized 
for your flat panel’s auto-calibrate feature allowing for improved image 
quality during the “auto-sync” process.

• Automatically align displays will snap multiple displays into alignment if 
they are slightly misaligned. This also fixes certain Windows issues where 
Windows can sometimes leave small gaps between displays.

Zoom, Hot Keys, and Other Features
The Effects, Zoom, and Hot Key tabs are accessible from the nView Desktop 
Manager properties panel. Effects and Hot Keys options offer additional 
enhancements, including:
• Faster opening and closing of windows
• A setting that automatically turns windows “transparent” when you drag 

them. This allows you to quickly see what is underneath a window without 
having to minimize or move it.

• A “zoom” tool that lets you see a zoomed up view of the area around the 
cursor. You can even use the zoom tool like a magnifying glass and drop it on 
top of what you want to magnify on the desktop

• A full set of hot keys. Virtually every action from toggling a window to be 
transparent to jumping to a different desktop can be assigned to a hot key.
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Window effects such as “zooming” and “transparency” are discussed in “Using 
Zoom Options” on page 101 and “Using Effects” on page 95. 
Hot Keys are discussed in “Using Hot Keys” on page 115.

Setup Wizard and Online Help 
• A Setup Wizard helps you get started with Desktop Manager. 
• On-line Help displays context-sensitive help when using Desktop Manager 

configuration options.

Application Compatibility
While the vast majority of applications are compatible with desktop and 
windows management, there are some applications that are not. If Desktop 
Manager detects these types of applications, it will not attempt to manage them. 
Depending upon the level of compatibility of the application, Desktop Manager 
may offer varying levels of functionality. 
Functionality that may be disabled for these applications includes support for 
Transparency and Individual Settings features, window position management, 
nView Desktop Manger menu options, and/or multiple desktop support. 
If an application window supports the nView Options Menu, but does not 
support certain Desktop Manager functions, a menu item called About this 
app... is added to the application’s nView option menu. In this case, you can 
click on this menu item to display information about the features that have been 
disabled for the application.
If you have any nView title bar buttons enabled, then an nView application 
status indicator appears to the left of the nView buttons. If the application does 
not support certain nView functions, this indicator will be red; otherwise it will 
be black. If the indicator is red, you can click it to display information about the 
features that have been disabled for this application. For further details, see 
“Using the User Interface Options” on page 123.

Examples of Incompatible Applications
Examples of application windows that do not support certain Desktop Manager 
features include:
• Command prompt (DOS window) under all operating systems. (All 

desktop management features are disabled.)
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• Solitaire and Freecell under Windows Me. (All window management 
features are disabled.)

• Microsoft PowerPoint. (The transparency feature is disabled.)

Skinning Utilities: Known Issues
If you use skins, Desktop Manager has been tested with several commonly 
available “skinning” utilities with no known compatibility issues other than 
those listed below. 
Some skins do not expose the application window’s system menu on its window 
frame (title bar). As a result, the nView options menu can only be accessed from 
either a title bar button (see “Enable nView Menu Options Title Bar Button” on 
page 129) or a hot key but not from the application window’s system menu. 
However, you can still access the nView options menu by right clicking the 
application on the taskbar. For details on the methods available for accessing an 
application’s system menu, see “Add nView Options to System Menus” on 
page 128.

System Requirements and Support
This section contains the following topics:
• “Operating Systems” on page 18
• “Disk Space” on page 18
• “Software: NVIDIA Display Driver” on page 19
• “Optional Software: Internet Explorer” on page 19
• “Optional: System Administrator Access Privileges” on page 19
• “Hardware: Supported NVIDIA Products” on page 19
• “Multi-Display Configuration: Tips and Requirements” on page 21
• “Multi-Display Mode and Feature Support” on page 21
• “Supported Languages” on page 22
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Operating Systems
This release of the nView Desktop Manager  driver is designed for the 
Microsoft Windows operating systems listed in Table 1.1: 

Note: Windows 98 and Windows Me are collectively called Windows 9x in this 
guide.

Disk Space
The release of nView Desktop Manager  has the following disk space 
requirements, based on the operating system you are using:

English
• Windows XP/2000: 18.3 MB
• Windows NT 4.0: 16.0 MB
• Windows 9x: 17.5 MB

Localized (non-English languages)
• Windows XP/2000: 19.5 MB
• Windows NT 4.0: 18.5 MB
• Windows 9x: 20.2 MB

Table 1.1 Operating System Requirements
Operating System Minimum Requirements
Windows XP Home and Professional Editions
Windows 2000  
Windows NT 4.0 Service Pack 4 
Windows Millennium Edition (Me)
Windows 98/Me Microsoft DirectX 5 

OSR2 (OEM Service Release 2) with USB supplement 
for full AGP support 
Microsoft OPENGL32.DLL
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Software: NVIDIA Display Driver 
You must have a current version of the NVIDIA Display Driver software for 
your Windows operating system. 
Make sure the current version of the NVIDIA Display Driver software for your 
Windows operating system has been installed on your computer. 
Consult your System Administrator if you are unsure about the version that is 
installed.
For further information on driver installation, see “Driver Installation And 
Uninstallation” on page 24.

Optional Software: Internet Explorer
You must have installed Microsoft Internet Explorer 6.0 or later version in 
order to access the “Desktop Explorer” feature as well as specific nView Menu 
Options that are available for Internet Explorer. See “Internet Explorer Options” 
on page 135.

Optional: System Administrator Access Privileges
You can use Desktop Manager with or without System Administrator access 
privileges. 
Note: However, certain Profiles features require System Administrator 

privileges under Windows NT 4.0 and Windows 2000/XP.

Hardware: Supported NVIDIA Products 
Table 1.2 lists the NVIDIA products supported by Desktop Manager.
Note: Some Desktop Manager features support only certain NVIDIA GPUs, 

which are noted in this table and where applicable in this guide.
Note: The Desktop Manager “transparency” feature works best with NVIDIA 

GPUs that have higher performance than GeForce2 GTS.
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Table 1.2 lists the NVIDIA products supported by the NVIDIA Display Driver 
software and the number of displays the GPU-based card supports.

Table 1.2 Supported NVIDIA Products

NVIDIA Desktop 
Products

NVIDIA Workstation 
Products

Number of Displays 
Supported Per Card

nForce™2 2— applies to all GPUs 
in this category.

nForce™ 420/420D
nForce™ 220/220D 

1— applies to all GPUs 
in this category.

GeForce™ 4 Ti 4600
GeForce™4 Ti 4400
GeForce™4 Ti 4200

Quadro®4 900 XGL
Quadro®4 750 XGL
Quadro®4 700 XGL

2 — applies to all GPUs 
in this category.

GeForce™ 3 Ti 500
GeForce™3 Ti 200
GeForce™3

Quadro® DCC 1 — applies to all GPUs 
in this category.

GeForce™ 4 MX 460 
GeForce™4 MX 440 
GeForce™4 MX 420 SDR 

Quadro®4 550 XGL
Quadro®4 500 XGL
Quadro®4 200 NVS (AGP)
Quadro®4 200 NVS (PCI)

2 — applies to all GPUs 
in this category.

Quadro®4 400 NVS (PCI) 4 — applies to all GPUs 
in this category.

GeForce™4 460 Go
GeForce™4 440 Go
GeForce™4 440 Go 64M 
GeForce™4 420 Go
GeForce™4 420 Go 32M 
GeForce™4 410 Go 16M 

Quadro®4 500 Go GL 2 — applies to all GPUs 
in this category.

GeForce™ 2 Ultra
GeForce™2 Ti
GeForce™2 GTS/Pro

Quadro®2 Pro

GeForce™ 2 MX 400
GeForce™2 MX 200
GeForce™2 MX

Quadro®2 MXR 2 — applies to all GPUs 
in this category.

Quadro®2 EX 1 — applies to all GPUs 
in this category.

GeForce™ 2 Go Quadro®2 Go 2 — applies to all GPUs 
in this category.

GeForce™ DDR
GeForce™ 256

Quadro® 1 — applies to all GPUs 
in this category.
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Multi-Display Configuration: Tips and Requirements
• When running Windows XP or Windows 2000 with more than two active 

displays, using “Dualview” mode is strongly recommended. 
• When running Windows with multiple cards (i.e., two or more NVIDIA 

GPU-based graphics card are installed in your computer), note the following:
• Using cards based on the same NVDIA GPU is strongly recommended.
• The same NVIDIA driver (version) must be installed for each card.

Note: For details on using nView multi-display modes, see “Using nView 
Multi-Display Modes: Dualview vs. Span/Clone” on page 27.

Multi-Display Mode and Feature Support
Table 1.3 lists details of supported operating system modes and Desktop 
Manager features for Windows 2000, XP, and 9x.

RIVA TNT™2 family 
RIVA TNT2 Ultra
RIVA TNT2 Pro
RIVA TNT2
RIVA TNT2 M64
NVIDIA Vanta
NVIDIA Vanta LT

--- 1 — applies to all GPUs 
in this category.

RIVA TNT™ --- 1

Table 1.2 Supported NVIDIA Products (continued)

NVIDIA Desktop 
Products

NVIDIA Workstation 
Products

Number of Displays 
Supported Per Card

Table 1.3 Multi-Display Mode and Feature Support

Supported Modes and Features
Windows 
XP 

Windows 
2000 Windows NT 4.0  Windows 9x

Is there nView Dualview support (default) 
for up to nine (9) display devices?

Yes Yes Yes Yes

Is nView Clone mode supported? Yes Yes Yes Yes
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Supported Languages

Languages Supported in the nView Desktop Manager 
Properties Pane

Are nView Span (Horizontal/Vertical) 
modes supported? 
Note: Using the current Release 40 drivers 
under Windows XP and Windows 2000, you 
can run nView Span mode with more than 
two displays. For example, if are using an 
NVIDIA GPU-based card to which you have 
connected four displays, you can have two 
sets of spanned displays. 

Yes Yes Yes NA

Does switching between nView Span/Clone 
mode and nView Dualview mode require 
restarting your computer?

No Yes Yes NA

Hardware Acceleration?
DirectX operations are accelerated if 
window is constrained to a single monitor 
otherwise operation is redirected to the 
software.
OpenGL support

Yes Yes DirectX: Yes
OpenGL: 
Acceleration is 
disabled in Dualview 
mode.

Yes

Are all nView Desktop Manager features 
supported?

Yes Yes Yes, except 
Transparency

Yes, except 
Transparency

Table 1.3 Multi-Display Mode and Feature Support (continued)

Supported Modes and Features
Windows 
XP 

Windows 
2000 Windows NT 4.0  Windows 9x

English (USA) German Portuguese (Brazil)
Arabic Greek Portuguese (Euro/Iberian)
Chinese (Simplified) Hebrew Russian
Chinese (Traditional) Hungarian Slovak
Czech Italian Slovenian
Danish Japanese Spanish
Dutch Korean Swedish
Finnish Norwegian Turkish
French Polish
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Languages Supported in the nView Desktop Manager Online 
Help 
English (USA) German Portuguese (Brazil)
Arabic Greek Portuguese (Euro/Iberian)
Chinese (Simplified) Hebrew Russian
Chinese (Traditional) Hungarian Slovak
Czech Italian Slovenian
Danish Japanese Spanish
Dutch Korean Swedish
Finnish Norwegian Thai
French Polish Turkish
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C H A P T E R

DRIVER INSTALLATION AND
UNINSTALLATION

This chapter contains the following major sections:
• “Before You Begin” on page 24
• “About nView Desktop Manager Installation” on page 24
• “Uninstalling the NVIDIA Display Driver Software” on page 26

Before You Begin
In order to access the nView Desktop Manager application, the latest version of 
the NVIDIA Display Drivers software for your Windows operating system must 
be installed on your computer.
Note: If you do not have System Administrator access privileges, it is assumed 

that the appropriate person with System Administrator access in your 
organization will set up and install nView on your computer.

Note: This chapter discusses the installation process but does not provide step-
by-step instructions on how to perform an actual installation.

About nView Desktop Manager Installation 
The nView Desktop Manager feature is part of your NVIDIA Display Driver 
Installation files and, therefore, is automatically installed when the NVIDIA 
Display Driver software is installed. 
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NVIDIA Driver Installation provides both an .INF file-based installation 
method and an InstallShield Wizard-based installation method.

File Locations 
• The installation process copies all nView Desktop Manager files that are 

necessary for operation into the appropriate directories.
• The nView Desktop Manager system files are copied to your Windows\

System directory.
• Profile files are saved in the Windows\Nview directory. 
• As part of the install process, an uninstall is registered in your system.
• Under Windows Me and Windows XP, the NVIDIA driver is installed in 

Dualview mode. However, note that the second display is not activated by 
default; you need to activate it in the Windows Display Properties Settings 
panel. For details on enabling Dualview mode, see “Using Multi-Display 
Modes: nView Dualview And Span/Clone” on page 24.

• Under Windows 2000, the NVIDIA driver is installed in Span mode.for all 
products except for the Quadro NVS series of products, which is installed in 
Dualview mode.

Preserving Desktop Manager Settings Before Upgrading 
Your Software
You can preserve your Desktop Manager settings by using profiles when you 
upgrade your software. 
Follow the steps below and/or refer to “Working With Profiles” on page 84 for 
details. 
1 Before uninstalling or installing software, save your current nView Desktop 

Manager settings to a new profile. 
For example, name this profile “My Settings”. 

2 Open the Windows\nView directory. 
You should see your new profile .tvp file in this directory; for example, My 
Settings.tvp.

3 You can copy this file to a disk in your A: drive or to a different directory on 
your hard drive to back it up.

4 Uninstall the currently installed NVIDIA Display Driver software on your 
system. See “Uninstalling the NVIDIA Display Driver Software” on page 26. 
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Note: The uninstallation program will ask if you want to delete your profiles. 
Choose No if you want to keep your existing profiles.

5 Install the new version of the NVIDIA Display Driver software. 
6 If you deleted your profiles in step 4, Copy your profile .tvp file back into 

the Windows\nView directory. 
7 Start nView Desktop Manager and load your profile. 

When you load this profile, all your nView Desktop Manager settings, 
including Individual Settings you may have set up for an application, will be 
restored. 

Uninstalling the NVIDIA Display Driver Software
Note: It is highly recommended that you follow the steps in this section to 

completely uninstall the NVIDIA Display Driver software before 
updating to a new version of the software. 

To uninstall the nView software, follow these steps:
1 From the Windows desktop, click Start > Settings > Control Panel > Add/

Remove Programs.
2 Click the “NVIDIA Display Drivers” choice from the list that appears.
3 Click Change/Remove.
4 Click Yes to continue. 
5 A prompt appears asking whether you want to delete all of the saved nView 

Desktop Manager profiles. 
Note: If you click Yes, the nView software and all of your saved profiles will 

be deleted. If you click No, the nView software is removed, but the 
profile files are saved in the Windows\nView directory on your hard 
disk.

Your system now restarts.
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C H A P T E R

USING NVIEW MULTI-DISPLAY MODES:
DUALVIEW VS. SPAN/CLONE

This chapter contains the following major sections:
• “nView Dualview vs. Span and Clone Modes” on page 27
• “nView Dualview Mode” on page 30
• “nView Span and Clone Modes” on page 45
• “Enabling nView Modes: Windows NT 4.0” on page 55
• “Multi-Display Mode: Arranging Displays on the Windows Display 

Properties Settings Panel” on page 56

nView Dualview vs. Span and Clone Modes
When using NVIDIA products that are multi-display capable, there are three 
ways to run multi-display configurations under most operating system; 
Dualview, Span, or Clone mode.
• nView Dualview and Span/Clone modes are mutually exclusive. This 

means that you cannot access nView Span or Clone Mode if you have 
Dualview mode enabled. Conversely, you cannot access Dualview mode if 
you have nView Span or Clone Mode enabled. 
Note: The nView Display Mode choice in the Media Center menu will 

always be visible under Windows XP/2000, whether or not you’re in 
Dualview mode (Figure 3.1). However, in Dualview mode, the nView 
Span and Clone options in the nView Display Mode panel will be 
disabled (grayed out) as shown in Figure 3.2.
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Figure 3.1 NVIDIA Media Center Menu 

Figure 3.2 nView Span/Clone Modes Unavailable in Dualview Mode

 

  

.

Media Center
menu

. 

nView Span and
Clone modes
are disabled
when Dualview
is enabled.
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Figure 3.3 nView Span/Cone Modes Available when Dualview Disabled 

• nView Dualview Mode has no special “nView multi-display mode” user 
interface since Dualview support conforms to the standard Microsoft user 
interface. The “Standard” mode in the panel shown in Figure 3.2 can be 
thought of as Dualview in that it is not Span or Clone mode.
Note: When you start Windows 9x or Windows XP using multiple displays, 

Windows is pre-configured for Dualview mode. This is not the case for 
Windows 2000. NVIDIA provides a special feature to “Enable 
Dualview” in Windows 2000.

For further information on using Dualview mode, see the following sections:
• “Key Features of nView Dualview Mode” on page 30
• “Enabling nView Dualview Mode for the First Time: Windows 2000” on 

page 32
• “Enabling nView Dualview Mode After Initial Session: Windows 2000” 

on page 38
• “Activating nView Dualview Mode: Windows XP” on page 38
• “Activating nView Dualview Mode: Windows 9x” on page 41

. 

nView Span and
Clone modes
are accessible
when Dualview
mode is disabled.

.
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• nView Span and Clone Modes: You can access Span or Clone modes 
(Figure 3.3) through the Advanced option on the Windows Display 
Properties Settings panel. (Windows 9x offers Clone mode only.)
For further information on using Span mode, see the following sections:
• “Key Features of nView Span Mode” on page 45
• “Enabling nView Span/Clone Modes” on page 47
• “Enabling nView Span/Clone Modes: Windows XP” on page 50
• “Enabling nView Clone Mode: Windows 9x” on page 52

nView Dualview Mode

Key Features of nView Dualview Mode
Dualview mode is sometimes called “native mode” as it is the native mode 
supported by Windows multi-display configurations; i.e. it is the “Microsoft” 
defined multi-display mode supported by Microsoft Windows operating 
systems. 
Figure 3.4 Multiple Display Devices in nView Dualview Mode

 Display 1: (resolution = 1280 x 768) Display 2: (resolution = 1024 x 768)

Background is not stretched across displays.Taskbar is not stretched across displays.
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Dualview support and functionality include the following:
• nView Dualview, Span, and Clone modes support advanced NVIDIA 

features such as Video Mirroring. See “Zoom Features: Display Properties 
vs. Desktop Manager” on page 104 and “Video Mirroring Options” on 
page 114.
Note: Windows NT 4.0 in Multiview mode does not support Video 

Mirroring.
• Windows places the taskbar on only a single display.
• Windows replicates (rather than stretches) the background on each display. 
• When you maximize an application, it maximizes only to the single display, 

and so on.
Figure 3.4 shows an example of a Dualview system where the left display is 
running at 1280x1024 and the right display is running at 1024x768. Notice 
that the background is not stretched across the displays and the taskbar 
appears on a single display instead of being stretched across displays.

• You can set different color depths per display.
• You can arrange your multi-display desktop to be any shape; it does not have 

to be limited to “rectangular” as in Span modes.
• When you run a DirectX or OpenGL application in Dualview mode, it is 

accelerated as long as the window does not span more than one display. If the 
window spans two displays, drawing is not accelerated in the window. 
Note: In Span mode, drawing is always accelerated.

• Dualview mode works for any display connected to your NVIDIA multi-
display graphics card: 
• PC monitor with an analog connector
• Flat Panel with a DVI connector
• TV with an S-Video connector. 
For example, you can have a system with the primary display as an analog 
PC monitor that supports up to 1600 x 1200 at 100 Hz refresh rate, while the 
secondary display is connected to an NTSC TV that is limited to 800 x 600 at 
60 Hz refresh rate. The TV has less resolution and refresh rate than the 
monitor since the TV encoder on the graphics chip has fewer capabilities 
than the analog PC monitor.
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Enabling nView Dualview Mode for the First Time: 
Windows 2000 
Note: When you start Windows 2000 with an NVIDIA GPU-based multi-

display graphics card (or multiple NVIDIA GPU-based graphics cards), 
you are not yet in “Dualview” mode*. You can confirm this when you 
view the Windows Display Properties Settings panel and see only one 
monitor image in the display.

Note: When you start Windows 2000 with an NVIDIA Quadro4 NVS GPU-
based card, Dualview is the default mode of operation.

The NVIDIA Desktop Utilities settings panel contains an option that lets you 
enable “Dualview” mode under Windows 2000. Follow these steps to enable 
Dualview.
1 Make sure you have a multi-display NVIDIA GPU-based graphics card, or 

dual graphics cards, properly installed in your computer and securely 
connected to your display devices.

2 Ensure that you have more than one display device attached to your multi-
display graphics card and that the display devices are turned on.

3 Confirm that the NVIDIA Display Driver software (including the nView 
Desktop Manager component) has been installed on your system.

4 Start up Windows.
5 From your desktop, right click to view the properties menu.
6 Click Properties > Settings (tab) > Advanced > the NVIDIA GPU tab > 

Desktop Utilities option from the Media Center menu to display the 
NVIDIA Desktop Utilities panel.

7 Click the Enable Dualview (Treat multiple outputs. . . ) option to enable it 
(Figure 3.5).and click Apply. The prompt in Figure 3.6 appears.

8 Click Restart Now. When the system starts up, you may see a series of 
Dualview installation prompts as shown in Figure 3.7. 
Note: It may take up to one minute for the first Dualview prompt to appear. 

9 Click Yes, Finish, and Yes to follow through and then restart your computer 
as prompted.
After the system starts up, if the NVIDIA nView Desktop Manager Setup 
Wizard appears, run through the Wizard by following the procedures in 
“Using the Desktop Manager Setup Wizard” on page 72.
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Figure 3.5 NVIDIA Desktop Utilities Panel: Enabling Dualview in Windows 2000

Figure 3.6 Restart Now Message: Enabling Dualview in Windows 2000
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Figure 3.7 Dualview Installation Messages: Windows 2000 

10From your desktop, right click to view the properties menu, then click 
Properties and the Settings tab.
You’ll notice that at least two monitor images appear on the Settings panel 
now, as shown in Figure 3.8. This is Dualview mode.
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Figure 3.8 Display Properties Settings: Dualview Mode (Windows 2000)

11Be sure to click the display image 1 so that it is the selected display. 
12Click Advanced to display the NVIDIA GPU tab, as shown in Figure 3.9.
13Click the NVIDIA GPU tab to display the associated panel and the Media 

Center menu, as shown in Figure 3.10. 
Note: The nView Display Mode option still appears in the Media Center menu 

as shown in (but the Clone/Span options are unavailable) because you 
are in Dualview mode.

Note: The nView Clone/Span modes are disabled because you are in nView 
Dualview mode. Remember that nView Dualview and nView Span/Clone 
modes are mutually exclusive. You cannot access Span and Clone modes 
until you disable Dualview; i.e., uncheck the Enable Dualview (Treat 
multiple outputs on. . .) option in the Desktop Utilities panel.

14Click OK to return to the Display Properties Settings panel. To turn on the 
secondary display (monitor image 2), go to the next section “Enabling 
(Turning on) the Secondary Display (Windows 2000)” on page 37.

15Click nView Display Mode to open the associated panel (Figure 3.11). 
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Figure 3.9 First Appearance of the NVIDIA GPU Tab (Windows 2000)

Figure 3.10 First Appearance of the Media Center Menu: Windows 2000

NVIDIA GPU tab

Media Center 
menu 
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Figure 3.11 nView Span/Clone Modes Unavailable in Dualview Mode: Windows 2000

Enabling (Turning on) the Secondary Display (Windows 2000)
1 From the Display Properties Settings panel, right click monitor image 

numbered 2 to display a pop-up properties menu.
2 Click Attached and click Apply. You will notice that the Extend my 

Windows desktop onto this monitor. . option becomes checked and your 
secondary display is enabled (Figure 3.12). 

nView Span/
Clone modes
are unavailable
in Dualview
mode.
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Figure 3.12 Display Properties Settings: Dualview Preparation (Windows 2000)

Enabling nView Dualview Mode After Initial Session: 
Windows 2000 
Switching back and forth from Dualview to Span/Clones mode under Windows 
2000 is much faster after the initial Dualview enable session.
On subsequent Dualview enabling sessions, you can use fewer steps, as follows:
1 Follow the basic steps in “Enabling nView Dualview Mode for the First 

Time: Windows 2000” on page 32 through step 9.
2 After your computer starts back up, your Dualview enabling is complete. 

You will not see any further Dualview messages and do not need to follow 
the remaining steps.

Activating nView Dualview Mode: Windows XP 
When you start Windows XP in multi-display configuration, Windows starts in 
“Dualview” mode. You may only need to do an “attach” procedure to enable the 
secondary display device. Follow these steps:
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1 Make sure you have an NVIDIA GPU-based multi-display graphics card 
installed in your computer.

2 Confirm that all your display devices are securely connected to your 
computer and turned on!

3 Confirm that the NVIDIA Display Driver software (including the nView 
Desktop Manager component) has been installed on your system.

4 Start Windows.
5 From your desktop, right click to open the properties menu, then click 

Properties and the Settings (tab). You’ll notice that two monitor images 
appear on the Settings panel, indicating that you are in Dualview mode.

Figure 3.13 Windows XP Display Settings in Dualview Mode (Display 1)

6 Now right click the monitor image that you need to attach. A pop-up 
properties menu appears.

Note: You may not need to do the next step if the secondary display device is 
already attached.

7 Click Attached and Apply. 
You will notice that the Extend my Windows desktop onto this monitor 
option becomes checked and your secondary display device is enabled.

8 Click Advanced. The NVIDIA GPU tab appears (Figure 3.15).
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9 Click the NVIDIA GPU tab. Notice that although you are in Dualview mode, 
you can see the nView Display Mode option in the Media Center menu.

Figure 3.14 Windows XP Display Settings in Dualview Mode (Display 2 attached) 

Figure 3.15 First Appearance of the NVIDIA GPU tab

NVIDIA GPU tab
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10Click nView Display Mode to display the associated properties panel. 
Notice that the nView Span/Clone mode options are disabled because you are 
in nView Dualview mode. (Figure 3.16)

Figure 3.16 nView Span/Clone Options Unavailable Under Dualview Mode (Win XP)

Activating nView Dualview Mode: Windows 9x

When you start Windows 9x in multi-display configuration, Windows starts in 
“Dualview” mode. You may only need to do an “attach” procedure to enable the 
secondary display device. Follow these steps

Notes: • Dualview mode is not supported under Windows 95.

• Under Dualview mode, when you switch to a full-screen 
Microsoft DOS window or boot to a DOS prompt, the display is 
limited to the primary display device.

• Under Dualview mode, OpenGL-based applications will only 
run using Microsoft’s software rendering implementation of 
OpenGL. This is due to a design limitation within Windows.

. 

nView Span and
Clone modes
are disabled
when Dualview
is enabled.
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1 Make sure you have an NVIDIA GPU-based multi-display graphics card 
installed in your computer and all your display devices are securely 
connected to your computer and turned on!

2 Confirm that the current version of the NVIDIA Display Driver software 
(including the nView Desktop Manager application) has been installed on 
your system.

3 Start Windows.
4 From your desktop, right click to open the properties menu, then click 

Properties and Settings (tab). You’ll notice that (at least) two monitor 
images appear on the Settings panel (Figure 3.17). This is Dualview mode.

Figure 3.17 Display Settings: Windows 9x 

Note: If you are using an NVIDIA multi-display graphics card (such as a 
GeForce4 MX) but have only one display device connected (such as a 
CRT), you will see two monitor images on the Settings panel even 
though only one display device is connected. You cannot enable the 
second display until you physically connect a second display device to 
the graphics card.

5 To turn on (enable) the secondary display (monitor image 2), go to the next 
section “Enabling (Turning on) the Secondary Display (Windows 9x)” on 
page 43.
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Enabling (Turning on) the Secondary Display (Windows 9x)
1 Right click monitor image 2 (Figure 3.18) and click Enabled to check the 

option. Notice that the Extend my Windows desktop onto this monitor 
option becomes checked (Figure 3.19).
Note: If you get a Compatibility Warning message, read the message 

carefully and then click OK.
Figure 3.18 Enabling Dualview (1): Windows 9x 

2 Click Apply. 
3 Be sure to click the display image 1 so that it is the selected display. 
4 Click Advanced and then click the NVIDIA GPU tab (Figure 3.20) to 

display the window in Figure 3.21. 
Note: Under Windows 9x, the nView Display Mode option does not appear 

at all in the Media Center menu because you are in Dualview mode.
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Figure 3.19 Enabling Dualview (2): Windows 9x 

Figure 3.20 First Appearance of the NVIDIA GPU Tab: Windows 9x

NVIDIA GPU tab
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Figure 3.21 NVIDIA Media Center Menu in Dualview Mode: Windows 9x

nView Span and Clone Modes 
nView Span, Clone, and Dualview modes support advanced NVIDIA features 
such as Video Mirroring. See “Zoom Features: Display Properties vs. Desktop 
Manager” on page 104 and “Video Mirroring Options” on page 114.
Note: Windows NT 4.0 Multiview mode does not support Video Mirroring.

Key Features of nView Span Mode
Span mode support and functionality include the following:
• DirectX or OpenGL applications in Span mode are fully accelerated.

• In nView Span mode, your Windows desktop is “stretched” or “spans” all of 
your displays. In Span mode, as far as Windows is concerned, you only have 
a single “logical” display device connected to your computer – the real 
“physical” displays are combined together to give you this “logical” display.

Media Center
menu

nView Display
Mode option 
containing
Clone mode
option is
unavailable
in Dualview
mode.
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Figure 3.22 Multiple Displays in nView Horizontal Span Mode

Figure 3.22 shows an example of running Span mode under Windows XP 
with both of the two displays set to 1280x1024 resolution. In this 
configuration, Windows recognizes only a single display running at 
2x1280x1024 or 2560x1024.

• The key to remember when running nView Span mode is that Windows does 
not detect that you have two displays connected – as far as it is concerned, 
you have an oversized display. This is the reason that you cannot use 
different bit depths or resolutions per display. 
Note: This also results in Span mode being slightly faster than Dualview 

mode because Windows only has to manage one display device instead 
of two.

• Under nView Span mode, Windows “stretches” the background wallpaper 
out to cover your large “logical” display and it stretches the taskbar out to fill 
your large “logical” display, as shown in Figure 3.22. If you maximize an 
application, the application will be maximized to fill the large “logical” 
display screen – i.e., both displays.

• Using the current Release 40 drivers under Windows XP and Windows 2000, 
you can run nView Span mode with more than two displays. For example, if 

 

.
.

Display 1 Display 2

Taskbar is stretched.
across displays

Background is stretched
across displays.
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are using an NVIDIA GPU-based card to which you have connected four 
displays, you can have two sets of two spanned displays. 

Enabling nView Span/Clone Modes

Enabling nView Span/Clone Modes: Windows 2000
Note: Under Windows 2000, switching between nView Span/Clone and 

Dualview modes requires restarting your computer.
To disable Dualview mode and, therefore, make nView Span and Clone modes 
accessible, follow these steps:
1 Click Properties > Settings tab.
2 Be sure to click the display image 1 so that it is the selected display. 
3 Click Advanced to display the NVIDIA GPU tab.
4 Click the NVIDIA GPU tab and then the Desktop Utilities option from the 

Media Center menu.
5 Click to uncheck the option Enable Dualview (Treat multiple outputs . . . ).
6 Click Apply and restart your computer. 

After the system starts up, if the NVIDIA nView Desktop Manager Setup 
Wizard appears, run through the Wizard by following the procedures in 
“Using the Desktop Manager Setup Wizard” on page 72.

7 Right click to display the properties menu, then select Properties > Settings 
tab. 
When you are in Windows 2000 (non-Dualview) nView Span or Clone 
mode, your Windows Display Properties Settings panel shows only one 
monitor image (Figure 3.23).

8 Click Advanced to display the NVIDIA GPU tab (Figure 3.24).
9 Click the NVIDIA GPU tab. The Media Center menu appears (Figure 3.25). 
10Click nView Display Mode to display the associated properties panel with 

the Span and Clone mode options available. (Figure 3.26).
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Figure 3.23 Windows 2000 Display Properties Settings in nView Span/Clone Mode 
(Dualview disabled) 

Figure 3.24 First Appearance of the NVIDIA GPU Tab: Windows 2000

 

NVIDIA GPU tab
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Figure 3.25 NVIDIA Media Center Menu: Windows 2000

Figure 3.26 nView Clone/Span Modes Available: Windows 2000

Media Center 
menu

. 

 

nView Span/Clone modes are available because
nView Standard (Dualview) mode is disabled.
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Enabling nView Span/Clone Modes: Windows XP
Note: Under Windows XP, you do not need to restart your computer to switch 

between nView Span/Clone Mode and Dualview mode.
When you are in Windows XP Span or Clone mode, your Windows Display 
Properties Settings panel shows at least “two” monitor images, unlike Windows 
2000, which shows only one monitor image.
To disable Dualview mode and, therefore, make nView Span and Clone modes 
accessible, follow these steps:
1 Open the Windows Display Properties Settings panel.
2 Right click the monitor image 2 and click Attached so that the option 

becomes unchecked. 
3 Click Apply (Figure 3.27). This turns off your secondary display. (To access 

nView Span and Clone modes, only one monitor needs to be enabled on the 
Display Settings panel.)

4 Be sure to click the display image 1 so that it is the selected display. 
Figure 3.27 Disabling Dualview Mode: Windows XP 

5 Click Advanced to display the NVIDIA GPU tab shown in Figure 3.28.
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Figure 3.28 First Appearance of the NVIDIA GPU tab: Windows XP

Figure 3.29 NVIDIA Media Center Menu: Windows XP

NVIDIA
GPU  tab

 

  

.

Media Center
menu
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6 Click the NVIDIA GPU tab to display the nView Display Mode option in 
the Media Center menu, as shown in Figure 3.29.

7 Click nView Display Mode to display the associated panel with the Span/
Clone mode options available (Figure 3.30).

Figure 3.30 nView Clone/Span Modes Available: Windows XP

Enabling nView Clone Mode: Windows 9x
Note: Under Windows 9x, Clone mode is available. Also, you do not need to 

restart your computer to switch between nView Clone mode and 
Dualview mode.

When you are in Windows 9x Clone mode, your Windows Display Properties 
Settings panel shows at least “two” monitor images, which indicates that you 
are in Dualview mode.

. 

nView Span and
Clone modes
are available
when Dualview
.

.

mode is disabled.
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To disable Dualview mode and, therefore, make nView Clone mode 
accessible, follow these steps:
1 Open the Windows Display Properties Settings panel.
2 Right click on the monitor image number 2 and click Enabled so that the 

option becomes unchecked and click Apply (Figure 3.31). This turns off your 
secondary display. (To access nView Span and Clone modes, only one 
monitor needs to be enabled on the Display Settings panel.)

3 Be sure to click the display image 1 so that it is the selected display. 
4 Click Advanced to display the NVIDIA GPU tab shown in Figure 3.32.
5 Click the NVIDIA GPU tab to display the Media Center menu (Figure 3.33)
6 From the Media Center menu, click nView Display Mode to display the 

associated properties panel (Figure 3.34).
Figure 3.31 Disabling Dualview: Windows 9x 
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Figure 3.32 First Appearance of the NVIDIA GPU tab: Windows 9x

Figure 3.33 NVIDIA Media Center Menu: Windows 9x

NVIDIA GPU tab

Media Center
menu
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Figure 3.34 nView Clone Mode Available: Windows 9x

Note: The nView Clone mode option is available, indicating that Dualview is 
disabled. (Under Windows 9x, Span mode does not appear.)

Enabling nView Modes: Windows NT 4.0
For details on enabling nView Multiview and nView Span/Clone modes under 
Windows NT 4.0, refer to the Application Note titled “Configuring Multiple 
Display Devices With Quadro4 NVS Cards”.

nView Multiview Mode: Windows NT 4.0
Note the following about running nView Multiview mode under Windows NT 
4.0:

• Under Windows NT 4.0, nView Multiview mode is only available with the 
NVIDIA Quadro4 NVS GPU-based series of graphics cards. 

• If you want to enable more than two display devices under Windows NT 
4, you must be running in Multiview mode, which supports up to sixteen 
(16) displays.

• Multiview mode does not support hardware accelerated OpenGL.

nView Clone
mode is available.

 .
when Dualview 
mode is disabled.
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nView Span/Clone Modes
Under Windows NT 4.0, Span mode allows you to use up to a maximum of two 
display devices. If you want to enable more than two display devices under 
Windows NT 4, you must change modes to nView Multiview mode, which 
supports up to sixteen (16) displays.

Multi-Display Mode: Arranging Displays on the Windows 
Display Properties Settings Panel

Note: The examples shown in Figure 3.35 through Figure 3.37 are Windows 
XP, but the procedure explained below applies to all Windows operating 
systems.

When using multiple displays, the desktop can be extended horizontally and 
vertically, as well as at other angles by repositioning the desktop monitor 
images in the Windows Display Properties Settings panel. You can drag the 
images to the positions that represent how you want to move items between 
your display devices. 
• For example, if you’re using two monitors and you want to move items from 

one monitor to the other by dragging left and right, position the images 
side-by-side (Figure 3.35). 

• To move items between monitors by dragging up and down, position the 
images one above the other (Figure 3.36).

• To move items between monitors by dragging at an angle, position the 
images diagonally (Figure 3.37). The positions of the images don’t have to 
correspond to the physical positions of your monitors. That is, you can 
position the images one above the other even though your monitors are side-
by-side. 
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Figure 3.35 Display Settings (Horizontal)  
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Figure 3.36 Display Settings (Vertical) 
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Figure 3.37 Display Settings (Diagonal)
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C H A P T E R

INFO PANEL:
ACCESSING AND ENABLING NVIEW
DESKTOP MANAGER PROPERTIES

This chapter contain the following major sections:
• “Overview” on page 60:
• “Enabling Desktop Manager from the Setup Wizard” on page 62
• “Accessing nView Desktop Manager Properties from the Windows 

Control Panel” on page 63
• “Enabling nView Desktop Manager from the Info Panel” on page 63
• “Enabling /Accessing Desktop Manager from the Desktop Utilities Panel 

and the Desktop Menu” on page 66
• “Enabling the Media Center Icon” on page 68
• “Using the Media Center Icon” on page 69
• “Accessing Windows Display Properties Settings” on page 70
• “Troubleshooting” on page 71

Overview
Once you have installed the NVIDIA Driver software with the nView Desktop 
Manager features, you can enable (load) and disable (unload) Desktop Manager 
using a variety of methods, as discussed in this section:
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1 After you enable Desktop Manager (following the instructions in this 
chapter), from your Windows desktop, you can right click to display the 
properties menu, which will now contain the nView Properties option, as 
shown in Figure 4.1.

Figure 4.1 Desktop Manager Enabled: nView Properties on Desktop Menu 

2 Click nView Properties to open the nView Desktop Manager properties 
panel, which will open on the Info tab, as shown in Figure 4.3.

Figure 4.2 Info Panel After Enabling Desktop Manager 
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Note: Several Desktop Manager functions such as performing operations on 
multiple windows within an application require Desktop Manager to be 
loaded before you start the application. For this reason it is highly 
recommended that you enable nView Desktop Manager as explained in 
the section “Enabling Desktop Manager from the Info Tab” later in this 
chapter.

Enabling Desktop Manager from the Setup Wizard 
The Desktop Manager Setup Wizard is a series of dialog boxes that guides you 
in setting the most common global settings for window, desktop, and 
application management. For details on using the Setup Wizard, see “Using the 
Desktop Manager Setup Wizard” on page 72.

Automatic Startup of Wizard
If you are setup with a multi-display configuration, the first time you start 
Windows on your computer after the installation of the NVIDIA Windows 
Display Driver, the Desktop Manager Setup Wizard starts automatically. 
If you are setup with only a single monitor, the first time you start Windows on 
your computer after the installation of the NVIDIA Windows Display Driver 
software, the Desktop Manager Setup Wizard does not start automatically. You 
can turn on nView Desktop Manager through the nView Info panel discussed 
later.
Note: Under Windows 9x, you only need to be running with an NVIDIA dual-

display GPU-based card for the Wizard to start automatically; multiple-
display devices need not be connected

While going through the Wizard, if you click the check box “Automatically 
Enable nView when starting Windows” then, after you complete running the 
Wizard, the following occurs:
• Desktop Manager is loaded 
• Each time you start Windows on your computer, Desktop Manager will be 

automatically enabled, until you disable or uninstall it. 
For details on using the Wizard, see “Using the Desktop Manager Setup 
Wizard” on page 72.
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Accessing nView Desktop Manager Properties from the 
Windows Control Panel

To access nView Desktop Manager settings from the Windows Control Panel, 
follow these steps:
1 From your Windows desktop, click Start > Settings > Control Panel.
2 From the Names column, click NVIDIA nView Desktop Manager (Figure 

4.3) to display the nView Desktop Manager properties panel (Figure 4.4).
3 If Desktop Manager is not enabled, the Enable nView Desktop Manager 

check box will be unchecked. In this case, click the check box and click 
Apply to enable the Desktop Manager.

4 To access the Windows, Effects, Hot Keys, or Profiles properties, click the 
corresponding named tab. 

5 To access the Desktop, Applications, User Interface or Tools options, 
check the Show Advanced nView Controls check box and click 
Apply.

Enabling nView Desktop Manager from the Info Panel 
To enable (load) or disable (unload) Desktop Manager using options in the Info 
panel, follow these steps:
1 Open the nView Desktop Manager properties panel. See “Accessing nView 

Desktop Manager Properties from the Windows Control Panel” on page 63. 
Figure 4.3 shows the Desktop Manager Info panel before Desktop Manager 
is enabled.
The Enable nView Desktop Manager option is a check box to enable/
disable Desktop Manager.
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Figure 4.3 Info Panel Before Desktop Manager is Enabled

2 Click the Enable nView Desktop Manager option and click Apply. 
Figure 4.4 shows the Desktop Manager Info panel after Desktop Manager is 
enabled. From your Windows desktop, right click to display the properties 
menu, which will now contain the nView Properties option (shown earlier in 
Figure 4.1).

Figure 4.4 Info Panel After Enabling Desktop Manager 
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Figure 4.5 Desktop Manager Enabled: nView Properties on Desktop Menu 

3 To enable the other advanced nView Desktop Manager options, click the 
Show Advanced nView Controls check box and click Apply. 
Several additional tabs now appear on the nView Desktop Manager 
properties panel, as shown in Figure 4.6.

Figure 4.6 Info Panel After Enabling Desktop Manager Advanced Options 
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Enabling /Accessing Desktop Manager from the Desktop 
Utilities Panel and the Desktop Menu

To enable (load) or disable (unload) Desktop Manager from the NVIDIA 
Desktop Utilities panel, follow these steps:
1 Right click from your Windows desktop.
2 To open the Desktop Utilities panel, click Properties > Settings tab > 

Advanced > NVIDIA GPU tab and the Desktop Utilities option from the 
Media Center menu (Figure 4.7).

3 To enable the nView Desktop Manager application, click the Enable 
Desktop Manager check box and click Apply (Figure 4.7). 
The nView Properties option is now added to your desktop properties menu. 

4 Right click from your desktop to view the desktop properties menu. You will 
see that nView Properties has been added to the menu (Figure 4.8).

Figure 4.7 Desktop Utilities: Enabling Desktop Manager 
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Figure 4.8 Desktop Manager Enabled: nView Properties on Desktop Menu 

5 You can click nView properties to open the nView Desktop Manager 
properties panel.
Also notice that the Desktop Manager Configuration button is activated on 
the Desktop Utilities panel (Figure 4.7). You can also click this option to 
view the nView Desktop Manager properties panel.

6 To disable the Desktop Manager, simply click the Enable Desktop Manager 
check box to remove the check mark and click Apply.
Right click from your Windows desktop and you will see that the nView 
Properties option no longer appears, indicating that the Desktop Manager 
has now been disabled.

Figure 4.9 Desktop Manager Disabled: nView Properties Removed from Desktop 
Menu 
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Enabling the Media Center Icon 
The Media Center icon allows you to apply any of the custom Direct3D, 
OpenGL or color settings "on the fly" from a convenient pop-up menu. The 
menu also contains items for restoring default settings and accessing the 
Windows Display Properties dialog box. 
You can access the following settings through the Media Center icon:

• Accuview Antialiasing 
• Custom OpenGL 
• Custom Direct3D 
• Custom Color 
• Rotation
• nView Desktop Manager 
• Windows Display Properties 

To enable the NVIDIA Media Center icon, follow these steps:
1 From your Windows desktop, right click to display the properties menu.
2 Then click Properties > Settings tab > Advanced > NVIDIA  GPU  tab and 

the Desktop Utilities option from the Media Center menu.
3 Click Display the Media Center icon in the taskbar to enable (check) this 

option and click Apply (Figure 4.10). 
Figure 4.10 Desktop Utilities: Enabling the Media Center Icon
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This adds the Media Center icon (Figure 4.11) to your Windows taskbar.
Figure 4.11 NVIDIA Media Center Icon

4 Go to the next section, “Using the Media Center Icon”. 

Using the Media Center Icon 
To use the Media Center icon on the Windows taskbar (Figure 4.11) simply 
right click the icon and then select the options you want from the menu that 
appears. The Desktop Manager menu is shown in Figure 4.12.
Figure 4.12 NVIDIA Media Center Icon: nView Desktop Manager Settings

1 To enable Desktop Manager, right click the Media Center icon on the 
Windows taskbar (Figure 4.11) and click nView Desktop Manager > 
Enable nView (Figure 4.12).

2 Again, right click the Media Center icon on the Windows taskbar and click 
Desktop Manager to confirm that the Enable nView option is now checked 
(Figure 4.12).
You can open the nView Desktop Manager control panel by clicking nView 
Properties from this menu. 
You can view saved profiles by clicking the nView Profiles option 
You can view desktops you’ve created by clicking the nView Desktops 
option.

Media Center icon
Windows Taskbar

.

Click nView
Properties to
open the nView
Desktop Manager
properties panel

Click nView Desktops
to view desktops you
have created.

Click nView Profiles
to view saved profiles.
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3 To disable Desktop Manager, right click the Media Center icon on the 
Windows taskbar and click Desktop Manager > Disable nView. 

4 Again, right click the Media Center icon on the Windows taskbar and click 
Desktop Manager to confirm that the “Disable nView” option is now 
checked .

Accessing Windows Display Properties Settings
From the nView Desktop Manager Properties Info panel, click the Display 
Settings . . option (Figure 4.13) to access the Windows Display Properties 
Settings panel. This convenient access to the Settings panel lets you quickly turn 
on (attach) or off (detach) your connected displays when you want to switch 
between nView Dualview and nView Span/Clone modes, for example.
Figure 4.13 Info Panel: Accessing Windows Display Properties Settings 

Click Display Settings to open

.
the Windows Display Properties
Settings panel where you can
attach or detach display devices,
as needed.
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Troubleshooting 
If you have trouble accessing the nView Desktop Manager properties panel, 
verify that a current version of the NVIDIA Display Driver software is installed 
on your system. You can follow these steps to verify this:
1 From your Windows desktop, right click to display the properties menu and 

then select Properties > Settings tab to access the Display Properties 
Settings panel. 
The “Display” field shows the name of your NVIDIA-GPU based graphics 
card; for example, “Monitor name on NVIDIA Quadro2 MXR/EX”.

2 Click Advanced and the NVIDIA GPU tab.
3 Verify that the “Driver Version Information” box lists the most recent 

versions of the NVIDIA driver files. Scroll down to confirm that all files 
have the same version number. If there’s any discrepancy, make sure you or 
your system administrator uninstalls the NVIDIA driver software according 
to the instructions in “Uninstalling the NVIDIA Display Driver Software” on 
page 26 and then reinstall the software.

Note: Make sure that the file nvdesk32.dll does not appear on the Driver 
Version Information list of files. This file is now obsolete and can result 
in inconsistencies. If you see this file, uninstall the NVIDIA Display 
Driver software and then re-install a current version.
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C H A P T E R

USING THE DESKTOP MANAGER
SETUP WIZARD

This chapter contains the following major sections:
• “About the Setup Wizard” on page 72
• “Starting the Setup Wizard” on page 73
• “Using the Setup Wizard” on page 75

About the Setup Wizard
The nView Desktop Manager Setup Wizard is a series of dialog boxes that 
guides you in setting the most common global settings for window, desktop, and 
application management.
Note: The Setup Wizard automatically starts when Desktop Manager is started . 

after first-time installation of the NVIDIA Windows Display Driver if 
more than one display device (monitor) is enabled on your system. . 
Under Windows XP, you may have to log out and log back in to continue 
with the Wizard.

Each Wizard window (step) contains descriptive text for a specific option and, 
in some cases, an illustration that shows the effect of the option; for example, 
window repositioning or spanning. You can also chose to skip major option 
groups.
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The options that can be set through the Wizard are:
• Profiles
• Windows Management (dialog boxes, windows spanning, nView menu 

options, etc.)
• Desktop Management (number of desktops; visibility in Windows Explorer, 

etc.)
• Transparency effects

Starting the Setup Wizard

Multi-Display vs. Single-Display Setup
• If you are setup with a multi-display configuration (i.e., you have more than 

one display device attached), the first time you start Windows on your 
computer after the installation of the NVIDIA Windows Display Drivers 
software, the Wizard starts automatically.
On subsequent Windows sessions, you can start the Wizard from the Wizard 
option on the nView Desktop Manager properties Info panel.

• If you are setup with only a single monitor, the first time you start Windows 
on your computer after the installation of the NVIDIA Windows Display 
Driver software, the Wizard does not start automatically. 
You can start the Wizard from the Wizard option on the nView Desktop 
Manager properties panel Info panel.

Manually Starting the Wizard
This sections contains the following topics:
• “Starting the Wizard From the Windows Control Panel” on page 73
• “Starting the Wizard from the nView Desktop Manager Info Panel” on 

page 75

Starting the Wizard From the Windows Control Panel
1 From your Windows desktop, click Start > Settings > Control Panel.
2 Locate the NVIDIA nView Desktop Manager icon and double-click it to 

display the Desktop Manager properties Info panel (Figure 5.1).
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Figure 5.1 Info Panel (default) Before Desktop Manager is Enabled

3 To enable Desktop Manager, click the Enable nView Desktop Manager 
check box and click Apply. Figure 5.2 shows the Desktop Manager Info tab 
after Desktop Manager is enabled.

Figure 5.2 Info Panel After Desktop Manager is Enabled)
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4 From your Windows desktop, right click to display the properties menu, 
which will now contain the nView Properties option (shown earlier in 
Figure 4.1).

5 Once you have loaded Desktop Manager, to unload it, uncheck the Enable 
nView Desktop Manager check box on the Desktop Manager Info tab 
(shown in Figure 5.1 and Figure 5.2) and click Apply. 

Starting the Wizard from the nView Desktop Manager Info 
Panel
If your Desktop Manager is already enabled, follow these steps:
1 Right click from your Windows desktop and click nView Properties.
2 From the Info tab that appears (Figure 5.2), click Wizard.

Using the Setup Wizard
The figures in this section show the step-by-step Wizard windows you will see 
when running the Desktop Manager Wizard. 
Use the following guidelines when using the Wizard:
• Use the Back and Next options to navigate through the windows.
• Carefully read the content of each page, which serves as a quick overview of 

key Desktop Manager features and lets you enable/disable certain key 
features by clicking a check box. 

• In most cases the default setting is that the option is not checked, i.e., 
disabled. Clicking the check box next to the option toggles between enabling 
and disabling the option.

• If you enable a feature, note that you can change this setting later through the 
nView Desktop Manager properties panel, which contains the Info, Profiles, 
Windows, Effects, Zoom, Applications, User Interface, Tools, Hot Keys, 
and Desktops tabs.

• If you do not want to enable one or more features in a given window, click 
Next to go to the next window.

Note: There may be some variation in the number and type of Wizard windows 
that appear, depending on your configuration; i.e., whether you are 
running Windows Me/9x (limited features), multiple desktops, and so on.
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Figure 5.3 nView Desktop Manager Wizard: Introduction 

Figure 5.4 nView Desktop Manager Wizard: Features Overview
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Figure 5.5 nView Desktop Manager Wizard: Using Desktop Manager

Certain Desktop Manager functions such as Individual Settings for applications 
and performing operations on multiple windows within an application require 
enabling Desktop Manager before you start the application. For this reason, it is 
recommended that in the above Wizard window (Figure 5.5), you enable nView 
Desktop Manager to load automatically at startup by checking the option 
Automatically enable nView when starting Windows. Then click Next to 
continue.
Figure 5.6 nView Desktop Manager Wizard: Loading and Using a Profile
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Note: From the Wizard window shown in Figure 5.6, if you want to skip the 
detailed configuration windows that would normally appear when you 
click Next, click the Skip the detailed configuration. . check box to 
enable the option and then click Next to go directly to the last window of

The Wizard windows in Figure 5.7 and Figure 5.8 appear only if you have a 
multi-display setup.
Figure 5.7 nView Desktop Manager Wizard: Window Spanning Control

Figure 5.8 nView Desktop Manager Wizard: Dialog Repositioning
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Figure 5.9 nView Desktop Manager Wizard: nView Menu Extension

Figure 5.10 nView Desktop Manager Wizard: Number of Desktops (1) 

Note: You can specify up to 32 desktops. Figure 5.11 shows a setting of “2” 
desktops. 
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Figure 5.11 nView Desktop Manager Wizard: Number of Desktops (2) 

Note: If you specified more than 1 desktop in the previous window, the window 
in Figure 5.12 appears.

Figure 5.12 nView Desktop Manager Wizard: Desktop Names 
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The next Wizard window (Figure 5.13) shows the “Turn on the Explorer 
extension” feature enabled. Notice how the “Desktop Explorer” extension is 
automatically added to your Windows Explorer.
Note: Microsoft Internet Explorer 6.0 or later version must be installed for the 

Desktop Explorer feature to work.
Figure 5.13 nView Desktop Manager Wizard: Turning on the Explorer Extension

Note: Since “Transparency” is not a supported feature under Windows 9x or 
Windows NT 4.0, the Wizard window in Figure 5.14 will not appear 
under Windows 9x or Windows NT 4.0.

Figure 5.14 nView Desktop Manager Wizard: Window Effects (Transparency) 
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Figure 5.15 nView Desktop Manager Wizard: Fast Windows Maximize

Figure 5.16 nView Desktop Manager Wizard: Completing Setup

After you click Finish to complete Desktop Manager Setup, you will see the 
Desktop Explorer prompt (Figure 5.17) if you enabled (or disabled) the Turn 
on Explorer extension in the Wizard.
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Figure 5.17 Desktop Explorer Prompt

1 Click Yes for the change to take effect, or No to ignore your change.
2 Once you log back in, the Desktop Manager Explorer extension should either 

be visible (sample Desktop Explorer extension is shown in Figure 5.18) in 
your Windows Explorer window or removed from Windows Explorer.

Figure 5.18 Desktop Explorer Extension in Windows Explorer

For details on working with the Desktop Explorer, see a variety of ways you can 
use Desktops features in “Using Desktop Explorer” on page 147.
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C H A P T E R

WORKING WITH PROFILES
This chapter discusses the following topics:
• “About Profiles” on page 84
• “Benefits of Using Profiles” on page 85
• “Accessing the Profiles Tab” on page 86
• “List of Profiles” on page 87
• “Current Profile” on page 87
• “Loading a Profile” on page 87
• “Creating a Profile” on page 87
• “Saving a Profile” on page 88
• “Deleting a Profile” on page 88
• “Include Display Settings in Profile Loads and Saves” on page 88
• “Copying Profiles for Use on Another Computer” on page 89

About Profiles
Profiles features can be used on both single-display and multi-display computer 
setups. 
Note: Under Windows NT 4.0 and Windows XP/2000, certain options such as 

creating, saving and exporting, and deleting profiles are only available to 
users with System Administrator access privileges.
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Using Profiles options, you can save all your Desktop Manager settings into a 
single file called a “profile”. To change how your desktop functions, you can 
subsequently load these profiles with a single “hot key” keystroke or by clicking 
the “Load Profile” option.
The profile contains all of the parameters for Desktop Manager, including 
multiple desktops and their backgrounds, individual (application) settings, user 
interface settings, keystone settings, and window management settings. You can 
also save your display mode settings (resolution, refresh rate, etc.) to a profile. 
Profiles are a “snapshot" of all your Desktop Manager settings. There is never 
an “active” profile; instead, you can reload your Desktop Manager settings 
“snapshot” and then edit it if you need to modify the settings.
Note: The profile file is not updated as you change Desktop Manager settings. 

Use the Save Profile option to update the profile with your new Desktop 
Manager settings. 

Benefits of Using Profiles
Using Profiles features, you can tailor different Desktop Manager modes to 
more closely match your operating needs and then easily switch between 
profiles with a hot key. 
You can use profiles to quickly switch your system configuration, depending on 
your needs. 
• For example, if you have a laptop that is sometimes docked with an extra 

monitor and sometimes undocked, you may want to have dialog boxes pop 
up on the laptop's screen while undocked but while docked, have dialog 
boxes appear on the extra monitor. In this case, you can set up two profiles on 
your system; a docked version and an undocked version with different 
settings. When you switch configuration (i.e., dock or undock your laptop), 
you can load your configuration with a single keystroke. 
Note: The loaded profile can also include turning on or off an external 

display connected to your laptop.
• If you work in a company with an IT department, profiles are even more 

useful. For example, a System Administrator can define a custom Desktop 
Manager mode and roll it out in one step to a department or other defined 
group in the company rather than have to configure each workstation 
separately. This can help reduce training and support costs since everyone 
within a group or department can use a common Desktop Manager 
configuration that is tailored for their needs.
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Accessing the Profiles Tab
To access the Desktop Manager Profiles panel, follow these steps: 
1 Open the nView Desktop Manager properties panel.

(If you need help accessing the nView Desktop Manager properties panel, 
see “Info Panel: Accessing and Enabling nView Desktop Manager 
Properties” on page 60.)

2 Click the Info tab, if you are not already there.
3 Enable the check box “Enable nView Desktop Manager” and click Apply.
4 Click the Profiles tab.
Figure 6.1 nView Desktop Manager Properties: Profiles Panel

Note: Creating (New Profile), saving and exporting (Save Profile) and deleting 
profiles (Delete Profile) are only available to users with System 
Administrator access privileges.

 

Profiles tab

List of profiles

Profiles panel
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List of Profiles 
When you go to the Profiles panel, you will see a list of profiles available for 
loading. Each profile in the list may have one of two icons next to it – a lock/
unlock icon (closed or open padlock) and a monitor icon. 
• A locked profile cannot have any settings modified when it is loaded. If you 

load a locked profile, you will not be able to change your nView settings until 
an unlocked profile is loaded. Unlocked profiles have no restrictions.

• If a profile has a monitor icon next to it, this means that there is display 
mode information stored in the profile. See “Include Display Settings in 
Profile Loads and Saves” on page 88” for more information.

Current Profile 
The “Current Profile” label (as shown in Figure 6.1) simply displays the name 
of the last profile you have loaded or saved. 
The Profiles panel example in Figure 6.1 shows the Current Profile as “generic” 
because generic is highlighted in the list.

Loading a Profile 
You can select a profile from the list and select Load Profile to load the profile.
• Examples of profiles you may see in the list are “generic”, “finance”, 

“CAD”, and “DCC”, depending on your NVIDIA GPU-based graphics card. 
• You may see additional profiles set up specifically for your company or 

organization if your System Administrator has set up custom profiles. 

Creating a Profile
The New Profile option lets you to create, name, and add a new profile that 
contains all of the current nView settings. Once saved, you can reload this 
profile at any time.
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Saving a Profile
Note: Under Windows NT 4.0 or Windows XP/2000, only users with System 

Administrator privileges can save (export) profiles.
The Save Profile option lets you overwrite the existing selected profile with 
your current nView Desktop Manager settings. 
• Profiles are saved with the .tvp file extension in the Windows\nView 

directory. 
• Once saved, you can reload this profile at any time.
• When you are saving to the profile selected from the list, a warning message 

indicates that you are about to overwrite the selected profile.
Click Yes to continue; otherwise, click No.

Deleting a Profile
The Delete Profile option lets you to delete the selected profile.
Note: Under Windows NT 4.0 or Windows XP/2000, only users with System 

Administrator privileges can delete profiles.
Note: When you are deleting the profile, a warning message indicates that you 

are about to lose all the settings in the selected profile you are about to 
delete. Click Yes to continue with the deletion process; otherwise, click 
No.

Include Display Settings in Profile Loads and Saves
Note: This feature is not supported under Windows NT 4.0.
The “Include Display Settings in Profile Loads and Saves” option lets you 
load display mode information from a profile if the profile has display mode 
information, which is indicated by a monitor icon next to the profile name. 
Display mode information includes the following:
• Number of enabled display devices 
• Position of the enabled display devices on the desktop
• Resolution, refresh rate, and bit depth per display
• Power state of the system 
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When this option is enabled (checked) and a profile with display mode 
information is loaded, nView Desktop Manager will attempt to apply the 
display mode stored in the profile to your computer. 
Note: If nView Desktop Manager cannot locate the hardware to support the 

display mode stored in the profile (for example, the profile mode 
information is to turn on four display devices but the computer that is 
loading the profile only has two display devices connected), then the 
display mode loading will silently fail. However, note that the nView 
Desktop Manager settings in the Profile will be loaded.

Note: If the “Include Display Settings…” check box is unchecked, then no 
matter what kind of profile you load, the display mode settings will not be 
applied to your computer.

1 To save a profile with your current display mode settings, follow these steps:
a Enable (check) the Include Display Settings… option before you use the 

Save Profile or New Profile options. 
b Click Apply. This will cause the computer’s current display state to be 

saved within the profile.
2 To save a profile without display mode information, follow these steps:

a Disable (uncheck) the Include Display Settings… option. 
b Click Apply before using the Save Profile option.

Copying Profiles for Use on Another Computer
A profile is simply a Desktop Manager data file. Therefore, it can be copied and 
pasted like any other file. Profile files are located in the Windows\nView 
directory on your hard disk and have a .tvp extension. 
To copy a profile file for use on another system, follow these steps:
1 From the Windows\nView directory on your hard disk, copy the .tvp 

profile file you want to a desired location, such as a diskette (in drive A:) or 
other network location. 

2 Then, be sure to paste this file to the Windows\nView directory on the 
computer where you plan to load this profile.

3 When you access the Desktop Manager Profiles settings on this new 
computer, you will see the name of the profile you just copied.

4 Select the profile and click Load Profile to load this profile.
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C H A P T E R

MANAGING WINDOWS
This chapter discusses the following major topics:
• “About Windows Options” on page 90
• “Accessing the Windows Tab” on page 91
• “Windows Management Options” on page 91
• “Window Control Options” on page 92
• “Dialog Box Control Options” on page 94

About Windows Options
The nView Desktop Manager Windows panel contains features that only apply 
to multi-display configurations. 
Note: The options on this panel will be disabled (grayed) if you are using only 

one display.
A key benefit of using windows management features is that you no longer have 
to spend your time resizing, relocating, or searching for windows because you 
can specify how you want your windows to function. You can specify how you 
want windows to operate on your desktops and/or display devices. 

For example, when you maximize an application under Span mode, it stretches 
across all display devices, which can be quite inconvenient. Using Windows 
management features, you can change this functionality to make the window 
only maximize to a single display device. Conversely, under Dualview mode, 
where windows normally maximize to a single screen, you can make 
applications maximize to the entire desktop. 
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Accessing the Windows Tab
To access the nView Desktop Manager Windows tab, follow these steps: 
1 Open the nView Desktop Manager properties panel.

(If you need help accessing the nView Desktop Manager properties panel, 
see “Info Panel: Accessing and Enabling nView Desktop Manager 
Properties” on page 60.)

2 Click the Info tab, if you are not already there.
3 Enable the check box Enable nView Desktop Manager and click Apply.
4 Click the Windows tab to display the Windows panel.
Note: Under nView Standard and Clone modes, the options on the Windows 

panel will be disabled (grayed out) since these options do not apply in 
these modes.

Windows Management Options
Figure 7.1 shows the nView Desktop Manager Windows tab when you are in 
Dualview mode; i.e., nView Clone/Span options are disabled. 
Figure 7.1 nView Desktop Manager Properties: Windows Panel (Dualview mode) 

 

Windows panel

Windows tab

This option appears under
nView Dualview mode.
91 N V I D I A  C o r p o r a t i o n



N V I D I A  n V i e w  D e s k t o p  M a n a g e r  U s e r ’ s  G u i d e

nViewGuide.book  Page 92  Wednesday, October 30, 2002  8:55 PM
Figure 7.2 shows the nView Desktop Manager Windows tab when the 
Windows Display Properties Settings panel is set to access nView Span 
(Horizontal or Vertical) mode under Windows 2000/XP.
Figure 7.2 nView Desktop Manager Properties: Windows Panel (nView Span mode)

There are slight differences in functionality between these two major modes, as 
explained in “Show full-desktop maximize option on title bar” on page 93 and 
“Show single-display max button on title bar” on page 93.
The settings in the Windows tab above are described in the sections that follow:
• “Window Control Options” on page 92
• “Dialog Box Control Options” on page 94

Window Control Options

Enable Window Spanning Across Displays 
This option allows windows to span (appear across) displays. When the option 
is disabled, all windows are prevented from spanning displays.
Default: Option is enabled (checked).

These options appear
under nView Span modes. 
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Enable child window spanning across displays 
Default: Option is enabled (checked). This means that child windows can span 
displays.
To access this option, you must first activate the “Enable window spanning 
across displays” option. 
Note: If you disable this option, all child windows are prevented from spanning 

displays even if the parent window does.

Show full-desktop maximize option on title bar 
If you are in nView Dualview mode, this option is displayed (Figure 7.1).
Note: To access this option, you must first activate the “Enable window 

spanning across displays” option.
When you enable this option, the nView window maximize button (square on 
the left of the title bar icons in Figure 7.3) is added to title bars on all application 
windows. 

Show single-display max button on title bar
If you are in nView Span (Horizontal or Vertical) mode under Windows 2000/
XP, this option is displayed (Figure 7.2). 
Note: To access this option, you must first enable the Enable window 

spanning across displays option.
When you enable this option, the nView window maximize button (square on 
the left of the title bar icons in Figure 7.3) is added to title bars on all application 
windows. 
Figure 7.3 Application Title Bar nView Maximize Button

Full-Desktop Maximize (Single-Display Maximize) button
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Note: From your open application, you can click this button to toggle a custom 
maximized state for your application window in multi-display 
configurations.

• In nView Dualview mode, the application window maximizes to the full 
desktop.

• In nView Span (Horizontal and Vertical) modes under Windows 2000/
XP, the application window maximizes to a single display. Therefore, the 
option is named “Show single-display max button on title bar” (Figure 
7.2).

Limit taskbar to a single display
Default: The option is disabled (unchecked).
Note: This option is available only when you are in nView Span mode. It does 

not apply under nView Clone or Dualview modes and therefore is not 
available in these modes.

When enabled, you can limit the taskbar to a single display instead of having it 
stretched across displays.

Dialog Box Control Options

Enable Dialog Box Repositioning
This option lets you specify the location of dialog boxes.
Default: Option is disabled (unchecked).

Center on monitor n 
This option repositions dialog boxes to a specific display device, where n is the 
number assigned to the display device when using a multi-display setup.
(This number is based on the monitor representations of the display devices on 
the Windows Display Properties Settings panel.)

Center on cursor’s monitor 
This option centers dialog boxes to the display device on which the cursor is 
located.

Locate on application’s monitor
This option repositions dialog boxes centered on the parent application’s 
display. 
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C H A P T E R

USING EFFECTS
The following major topics are discussed in this chapter:
• “About Effects” on page 95
• “Accessing the Effects Tab” on page 96
• “Window Drawing Enhancements” on page 97
• “Windows Color Keying” on page 98

About Effects 
The Desktop Manager Effects panel provides 2D and 3D features for windows 
on the desktop. Effects features can be used in both single-display and multi-
display computer setups. 
Among the features you can enable from the Effects panel is increasing the 
speed of windows opening/closing and to change Windows behavior to 
automatically activate windows underneath your cursor. You can also add 
transparency support to windows on the desktop. 
Key benefits of using Effects features are the following:
• Speed up maximizing, minimizing restoring, and opening windows. 

• Making a window transparent effectively gives you more space on your 
desktop
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Accessing the Effects Tab
To access the Desktop Manager Effects panel, follow these steps: 
1 Open the nView Desktop Manager properties panel.

(If you need help accessing the nView Desktop Manager properties (tabs), 
see “Info Panel: Accessing and Enabling nView Desktop Manager 
Properties” on page 60.)

2 Click the Info tab, if you are not already there.
3 Click the check box Enable nView Desktop Manager to enable the option.
4 Click Apply.
5 Click the Effects tab to display the Effects panel shown in Figure 8.1.
Figure 8.1 nView Desktop Manager Properties: Effects Panel 

Effects panel

Color Keys: Double-click any of the
colors to display the Color Key
Properties dialog box where you can
enable, disable, or edit the color.

Effects tab
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Window Drawing Enhancements

Make Windows Minimize and Maximize Faster
This option accelerates Open, Maximize, and Restore window functions.

Automatically Activate Windows Under Cursor
This option automatically activates and brings the window under the cursor to 
the front when the cursor is over it for more than 0.5 seconds.

Make Windows Transparent When Dragged 
This option enables window transparency when windows are dragged. 
Windows become transparent as you hold down the mouse option while on the 
window’s title bar, allowing you to quickly see what is underneath the window. 
When you release the mouse option, the window becomes opaque.

Enable Drop-down Menu Transparency
This option makes drop down menus transparent when they are opened on 
opaque windows (note that if the window is transparent, the drop down menu 
will open in an opaque state no matter the setting of this check box).

Enable Taskbar Transparency
This option makes the desktop taskbar transparent

Transparency Level
This option sets the degree of transparency for the transparency features above. 
The higher the percentage you select, the more transparent the window appears.
Note: You can change the transparency level of an individual application using 

the Individual Settings feature. For details, see Chapter 14 “nView 
Desktop Manager Properties (Applications): Individual Application 
Settings” on page 170, which discusses the features of the Applications 
panel.

Note: Transparency percentage values are limited to a maximum of 80%. 
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Notes on Transparency Support
• Transparency is only supported on Windows 2000/XP. 
• Transparency can take a lot of processing power. If Desktop Manager detects 

that your system may be sluggish when dragging large transparent windows, 
you will be given an option to disable transparent window dragging for 
windows larger than a certain size.

• Transparency is disabled when a 3D or hardware overlay application is 
running.

• Some applications do not support transparency, in which case, an About this 
app . .. menu choice is added to the nView Extension menu for that 
application.

Windows Color Keying

Enable Windows Color Keying
When you enable this option, nView Desktop Manager colors the border of 
application windows according to:
• Individual Application Settings (if you have enabled this option, see 

“Individual Settings” on page 132 or “Individual Application Settings” on 
page 169) or 

• Automatically assign colors. . option described below. 

Manipulating Color-Keyed Windows Using Hot Keys
Color keyed windows can then be manipulated using Color-Keyed hot keys that 
you can define using options on the Hot Key panel. When you press a color hot 
key combination, it will toggle the corresponding color-keyed window to be 
brought to the forefront, maximized, and visible on all desktops. In other words, 
it allows for a window to be immediately accessible with a single keystroke no 
matter where on the desktop(s) the window lies.
For details, see “Description of Actions” on page 117 in Chapter 10, Using Hot 
Keys.

Automatically Assign Colors to Windows
When enabled, nView will automatically color key windows that are open on 
the desktop using enabled colors not used by individual application settings. 
Colors will be automatically chosen out of the color pool as long as colors are 
available. If all colors have been used, new windows will not be colored.
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Using the Color Key table
To enable, disable, or edit any of the colors in the Color Key table (shown in 
Figure 8.1), follow these steps:
1 Double-click any of the colors to display the Color Key Properties dialog box 

shown in Figure 8.2.
Figure 8.2 nView Desktop Manager Effects: Color Key Properties

2 To disable the color to be used with the Color Keyed windows, click the 
checked box to remove the check mark and click OK. Notice that the color 
for that number (in this case “4”) is removed from the Color Keyed table in 
the Effects panel.

3 To enable a color, follow these steps:
a Click a uncolored box number (“4” in this case since it was disabled in the 

previous example) to display the Color Key Properties dialog box again. 
b Click the Enable the color key . . . . . check box to insert the check mark.
c Click OK. 

4 To edit the color to be used with the Color Keyed window, follow these 
steps:
a From the Effects panel, double-click the color number you want to edit.
b Click the Edit Color options from the Color Key Properties dialog box.
c Choose the color you want from the Color palette dialog box and click OK 

to return to the Color Key Properties dialog box. Notice the new color is 
reflected in the Current Color field.

5 Click OK. Notice the new color for the number is reflected in the Color Key 
table on the Effects panel.
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Colored Application Window Borders
Figure 8.3 shows sample applications with colored window borders.
Figure 8.3 nView Desktop Manager Effects: Sample Colored Application Window 

Borders 
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C H A P T E R

USING ZOOM OPTIONS

This chapter contains the following sections:
• “About Zoom Options” on page 101
• “Accessing the Zoom Tab” on page 102
• “Zoom Features: Display Properties vs. Desktop Manager” on page 104
• “Zoom Window Style” on page 104
• “Use the Mouse Wheel to Change Zoom Levels” on page 105
• “Show Cursor in Zoom Window” on page 105
• “Automatically Move Zoom Window to Next Screen” on page 105
• “Enable Bi-Directional Editing” on page 106
• “Enable Zoom of Video Playback (disables overlay)” on page 106
• “Show Zoom Window” on page 107
• “Video Mirroring Options” on page 114

About Zoom Options
The Zoom feature of Desktop Manager provides dynamic zoom functionality on 
the desktop. Zoom features can be used by both single-display and multi-display 
users. Among the zoom features you can enable from the Zoom panel is a 
resizable “zoom window” to zoom in on areas of the desktop for easier reading 
or for fine editing. 
Key benefits of using Zoom features are the following:
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• You don’t have to change resolutions to view and/or edit small graphics or 
text – you can simply open up your “zoom” window. 

• You can display a portion of your desktop on a second display without 
additional hardware.

Accessing the Zoom Tab
To access the Desktop Manager Zoom panel, follow these steps: 
1 Open the nView Desktop Manager properties panel.

(If you need help accessing the nView Desktop Manager Properties (tabs), 
see “Info Panel: Accessing and Enabling nView Desktop Manager 
Properties” on page 60.)

2 Click the Info tab, if you are not already there.
3 Click the check box Enable nView Desktop Manager to enable the option.
4 Click Apply.
5 Click the Zoom tab.
Figure 9.1 Desktop Manager Properties: Zoom Panel (Center on cursor) 

Zoom panel

Zoom tab
N V I D I A  C o r p o r a t i o n 102



C h a p t e r  9 U s i n g  Z o o m  O p t i o n s

nViewGuide.book  Page 103  Wednesday, October 30, 2002  8:55 PM
Figure 9.2 Desktop Manager Properties: Zoom Panel (Magnifying glass) 

Figure 9.3 Desktop Manager Properties: Zoom Panel (Fixed Frame) 
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Zoom Features: Display Properties vs. Desktop Manager
If you are using an NVIDIA multi-display GPU-based graphics card, you have 
several zoom options available. 
• If you just want a Windows tool that lets you zoom certain areas of the 

desktop in a window, use the “Zoom Window” tool described in this section.
• If you are specifically interested in zooming video playing back on your 

computer from a DVD or other video source, it is recommended that you use 
the Overlay Video Mirroring controls described in the NVIDIA Display 
Properties User’s Guide. You can set up Video Mirroring to zoom and 
automatically display full-screen video on your second display device. 
Note: The nView Desktop Manager Zoom panel contains the Video Mirror 

Controls. Clicking this option will give you access to the Overlay 
Controls panel where you can set Video Mirror options.

Zoom Window Style
This selection controls what type of Zoom window you want to open. nView 
Desktop Manager supports three types of Zoom windows:
• Magnifying glass
• Centered on cursor
• Fixed frame

Magnifying Glass
This option creates a magnifying glass style zoom window when you launch a 
Zoom Window. The magnifying glass zoom window contains a white square 
inside the zoom window. For details on using this option, see “Using 
Magnifying Glass Style Zoom” on page 110.

Centered on Cursor 
This option creates a zoom window that displays a magnification of the area 
around the mouse cursor when a zoom window is launched. For details on using 
this option, see “Using Cursor Style Zoom” on page 109
N V I D I A  C o r p o r a t i o n 104



C h a p t e r  9 U s i n g  Z o o m  O p t i o n s

nViewGuide.book  Page 105  Wednesday, October 30, 2002  8:55 PM
Fixed Frame
This option creates a zoom window that displays a magnification of a fixed area 
on your desktop. For details on using this option, see “Using Fixed Frame 
Zoom” on page 112.

Use the Mouse Wheel to Change Zoom Levels 
• Enable the “Use the mouse wheel to change zoom levels...” option if you 

want to use the mouse wheel to change zoom levels when a zoom window is 
active. 
In addition, or as an alternative, you can also use the “Zoom Level” menu 
from the Zoom Window to change zoom levels. See “Zoom Window Menus” 
on page 107.

• If you want to use the mouse wheel to change zoom levels while holding 
down one of the following keys (Shift or Ctrl), then follow these steps:
a Click the Use the mouse wheel to change zoom levels. . . . check box to 

enable the option.
b Then click Shift and/or Ctrl.
c Click Apply.

Show Cursor in Zoom Window
Note: This option doesn’t apply under Magnifying Glass zoom.
This option causes the mouse cursor to be shown in the zoom window when 
enabled (checked). This feature only applies to centered on cursor and fixed 
frame zoom styles. When enabled, the mouse cursor will be shown in the zoom 
window if the mouse cursor is in the area of the screen that is being zoomed. 
When disabled (unchecked), the mouse cursor will not appear in the zoom 
window.

Automatically Move Zoom Window to Next Screen
Note: This option doesn’t apply under Magnifying Glass or Fixed Frame zoom.
When this option is enabled and the Zoom window is maximized to a single 
display (not the full desktop), Desktop Manager will automatically move the 
window to the next display (screen) if your cursor moves onto the Zoom 
window.
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Enable Bi-Directional Editing
Note: This feature applies only to the Magnifying Glass and Fixed Frame 

style zoom windows and cursor-related functions, but not text editing. 
Also note that this option does not work with the Magnifying Glass style 
zoom window if any transparency features are enabled.

When enabled, nView Desktop Manager allows you to use your mouse with 
applications under either Magnifying Glass or Fixed Frame Zoom windows 
using the application’s standard mouse editing methods.
Using an example of the Microsoft Accessories Paint program, (Start > 
Programs > Accessories > Paint), follow these steps:
1 Open the Zoom window (see “Show Zoom Window” on page 107 for details) 

and place the Magnifying Glass Zoom or Fixed Frame Zoom over the Paint 
window so that the drawing buttons as well as some of the paint area is being 
magnified. 

2 Press the paint buttons on the Zoom window (not the paint window) and then 
draw directly on the zoom window. This allows for easier editing since the 
area is magnified. 

Enable Zoom of Video Playback (disables overlay)
Note: This option doesn’t apply under Magnifying Glass zoom.
The Zoom Window cannot zoom video data contained in hardware overlay 
windows. Hardware overlay is used by default to play back video data. Thus if 
you open a video playback window, the Zoom window normally will not zoom 
the data.
This option lets you disable hardware overlay when the zoom window is open. 
This forces video playback not to use hardware overlay. 
Note: This setting does not affect videos that are currently playing when the 

Zoom window opens but only affects video windows opened after the 
Zoom window. In other words, if a video is playing before you open a 
zoom window, the video data will not be zoomed. If a video is opened 
after the zoom window is open, the video data will be zoomed if this 
option is set.
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Show Zoom Window
This option, when checked, opens a “Zoom Window” that can display a 
magnification of a selected area of your screen using the zoom style you have 
selected (i.e., “Magnifying Glass”, “Centered on Cursor”, or “Fixed Frame” 
style zooming). 
• When a Zoom window is open, this button changes to Hide Zoom Window. 

Pressing the button when it is labeled “Hide Zoom Window” will close the 
open Zoom window.

• Using the Zoom Window, you can change zoom levels, the update rate of the 
zoomed data, and even toggle the window on or off with a hot key.

Zoom Window Menus

The following topics are discussed in this section:
• Zoom Level
• Zoom Refresh
• Zoom Style
• Using Cursor Style Zoom
• Using Magnifying Glass Style Zoom
• Using Fixed Frame style Zoom

Zoom Level 
Zoom Level can be set from 1x to 10x (Figure 9.4).
Note: You can also change zoom levels with the mouse wheel by itself or in 

combination with the Ctrl and/or Shift keys if you selected this option in 
the Zoom panel
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Figure 9.4 Zoom Level Menu

Zoom Refresh 
Zoom Refresh can be set from 5 frames/second to 30 frames/seconds, in 
increments of 5 (Figure 9.5).
Note: Higher refresh rates require more processing power.
Figure 9.5 Zoom Refresh Menu

Zoom Style 
Zoom Style can be set to any one of the following settings as shown in Figure 
9.6 and Figure 9.7.
• Centered on cursor
• Magnifying glass
• Frame Window
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Figure 9.6 Zoom Style Menu 

Using Cursor Style Zoom
When you click the Show Zoom Window option with the Centered on Cursor 
option enabled (checked), the cursor style zoom window appears (Figure 9.8). 
Figure 9.7 Cursor Style Zoom Window (1)

Figure 9.8 Cursor Style Zoom Window (2) 
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To use the Cursor style zoom, follow these steps:
1 Move your mouse cursor to the area of your screen (or open application) that 

you want to zoom. You will see the area magnified in the Zoom Window, as 
shown in the bottom window in Figure 9.9. 

2 You can keep moving your mouse cursor to any area you want to zoom.
Figure 9.9 Cursor Style Zoomed Area in Zoom Window

3 Adjust the zoom level to increase or decrease the size the contents you are 
viewing. To adjust the zoom level you can either use the mouse wheel (or the 
mouse wheel and the Ctrl/Shift key options) or the Zoom Level menu 
options on the Zoom Window.

Using Magnifying Glass Style Zoom
Selecting Magnifying glass Zoom Style (shown in Figure 9.6) is equivalent to 
enabling the Magnifying Glass option on the Zoom panel. 
When you click the Show Zoom Window option from the Zoom panel with the 
Magnifying glass option enabled (checked), the magnifying glass style zoom 
window appears with a white square inside the window (Figure 9.10). 
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Figure 9.10 Magnifying Glass Style Zoom Window

To use the Magnifying Glass style zoom, follow these steps:
1 Adjust the zoom level to increase or decrease the size of the white square. To 

adjust the zoom level you can either use the mouse wheel (or the mouse 
wheel and the Ctrl/Shift key options) or the Zoom Level menu options on 
the Zoom Window.

2 Click on the title bar of the Zoom window and drag the zoom window over 
the area on the screen that you want to magnify so that the transparent white 
square encompasses the area to magnify. Figure 9.11 shows an example of 
the magnifying glass style zoom window covering an area of an open 
window. Note the white box surrounding the display area.

Figure 9.11 Magnifying Glass Style Zoom Window Over Zoom Area
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3 Release the mouse option. The section of the screen inside the transparent 
white square now becomes magnified to fill the entire zoom window. Figure 
9.12 shows the result of a magnifying glass zoom.

Figure 9.12 Magnifying Glass Style Zoomed Area in Zoom Window

Using Fixed Frame Zoom
When you click Show Zoom Window from the Zoom panel with the Fixed 
Frame option enabled (checked), the Zoom Window opens along with a 
second, smaller “zoom source” window labeled “Zoom Window - Fixed 
Frame”, as shown in Figure 9.13.
To use the Fixed Frame style zoom, follow these steps:
1 Confirm that the Zoom Style is set to Fixed Frame.
2 Click Show Zoom Window.

In the Figure 9.13 example, the small Zoom Window-Fixed Frame “zoom 
source” window appears on the right and the resulting magnified area is 
shown in the larger Zoom Window.

3 Move the small “Zoom Window – Fixed Frame” window (labeled in Figure 
9.13) to another area of the desktop that you want to zoom. 
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Figure 9.13 Zoom Window-Fixed Frame Window

Figure 9.14 Magnified Area in Zoom Window ( Zoom Window - Fixed Frame Window 
is Hidden) 

-
 

Large Zoom Window showing magnifica-
tion of the image in the “Zoom Window -

“Zoom source” Zoom Window - Fixed
Frame window can be moved to 
different areas on your desktop.Fixed Frame “zoom source” window

shown on the right.

 
  

Click the Fixed Frame menu option to re-display (unhide) 
the “zoom source” Zoom Window-Fixed Frame window.
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Note: Now that you have adjusted the position of the Zoom Window - Fixed 
Frame “zoom source” window, it is automatically hidden while the 
magnified contents are displayed in the large Zoom Windows, as 
shown in Figure 9.14.

4 To toggle the Zoom Window - Fixed Frame “zoom source” window on and 
off (display or hide), click the Fixed Frame menu option on the main Zoom 
Window, as shown in Figure 9.14.

When the Zoom Window is not active, the “zoom source” window will 
be hidden but the area where it was last dropped will continue to be 
zoomed and shown in the Zoom Window. 
a To re-display the Zoom Window - Fixed Frame window, click the Fixed 

Frame menu option in the main Zoom Window.
b Then move the now visible Zoom Window - Fixed Frame window to the 

new area of the desktop you want to zoom."
5 To adjust the zoom level, use either the mouse wheel or the mouse wheel and 

the Ctrl/Shift key options or the Zoom Level menu options on the main 
Zoom Window. 
Note: You can adjust the zoom level to increase or decrease the size of the 

Zoom Window – Fixed Frame. In other words, the higher the Zoom 
Level you set, the smaller the size of the Zoom Window – Fixed 
Frame becomes.

Note: You can also adjust the zoomed area by resizing the main Zoom 
Window.

Video Mirroring Options
To display full-screen video on one of your display devices, click Video 
Mirroring Options to open the NVIDIA Overlay Controls panel. 
Note: Your computer must be set to nView Clone or Dualview mode in order 

to use Video Mirror features.
For further details on using the Video Mirroring options, refer to the NVIDIA 
Display Properties User’s Guide.
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C H A P T E R

USING HOT KEYS
The following topics are discussed in this chapter:
• “About Hot Key Options” on page 115
• “Accessing the Hot Keys Tab” on page 116
• “Selecting an Action” on page 117
• “Adding a Hot Key” on page 119
• “Removing a Hot Key” on page 121
• “Removing All Hot Keys” on page 121
• “Active Hot Keys List” on page 121

About Hot Key Options
The Hot Key features can be used by both single-display and multi-display 
users. 
nView Desktop Manager lets you set up hot keys (shortcut keys or key 
combinations) to access and perform virtually every action of the Desktop 
Manager that is available from its Windows, Profiles, Desktops, and other 
panels. The key benefit of using hot keys is quick access to common functions 
with a single keystroke.
Using the Hot Keys features (Figure 10.1), you can
• Quickly add new hot keys to the list through selecting from available actions 

and then clicking Add.
• View a list of hot keys that you have defined for your system.
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Accessing the Hot Keys Tab
To access the Desktop Manager Hot Keys panel, follow these steps: 
1 Open the nView Desktop Manager properties panel.

(If you need help accessing the nView Desktop Manager Properties (tabs), 
see “Info Panel: Accessing and Enabling nView Desktop Manager 
Properties” on page 60.)

2 Click the Info tab, if you are not already there.
3 Click the check box Enable nView Desktop Manager to enable the option.
4 Click Apply.
5 Click the Hot Keys tab to display the Hot Keys panel (Figure 10.1).
Figure 10.1 nView Desktop Manager Properties: Hot Keys Panel 

Hot Keys tab

Hot Keys panel
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Selecting an Action
The Select an Action list box (Figure 10.1) displays a list of actions that can be 
performed when you press a key or combination of keys, i.e., assigned hot keys 
for the actions.
1 Click an action to select it. 
2 Use the scroll bar to access the complete list of actions. The actions and their 

descriptions are listed below. 
3 Go to the section “Adding a Hot Key” on page 119 to assign the hot key to 

the selected action.

Description of Actions
• “Open nView control panel” opens the nView Desktop Manager properties 

panel. 
• “Run application…” runs a user-specified application. Note that after 

selection, a browse file dialog appears where you can select the program file 
you want to run.

• “Locate cursor” highlights the area around the cursor allowing it to be 
located on the desktop.

• “Gather all windows to Mon1” moves all open windows and dialog boxes 
on your system to display 1 of the active desktop.

• “Toggle zoom window” shows and hides the zoom window.
• “Load profile…” loads a saved profile. 
• “Move window to monitor…” moves the active window to a user-specified 

display. 
• “Move window to desktop…” moves the active window to a user-specified 

desktop. 
• “Max/Restore window” toggles between the Windows maximize/restore 

function on the active window. 
• “NVMax/Restore window” toggles between the nView Desktop Manager 

maximize and restore functions on the active window. This functionality is 
also available by using the nView Desktop Manager title bar buttons as 
explained in “Show full-desktop maximize option on title bar” on page 93 
and “Show single-display max button on title bar” on page 93.

• “Collapse/Restore window” toggles between collapsing the application 
window to its title bar and restoring the window to its former size.
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• “Toggle transparency” toggles the active window between being 
transparent and opaque.

• “Toggle always on top” toggles the active window between being always on 
top or not being on top.

• “Show Color-Keyed window” lets you easily control color-keyed windows. 
After you define a hot key corresponding to a color (for details, see 
“Examples of Actions Requiring Additional Information” on page 120), then 
when you press this hot key, it will toggle the corresponding color-keyed 
window to be brought to the forefront, maximized, and visible on all 
desktops. In other words, it allows for a window to be immediately accessible 
with a single keystroke no matter where on the desktop(s) the window is 
located.

• “Show on all desktops” toggles the active window between showing on all 
desktops or on a single desktop.

• “Collapse to desktop” causes the active window to show on the current 
desktop only.

• “Activate desktop…” switches the display to a user-specified desktop. 
After you enter the keystroke in the text box and click Add, a list box appears 
with all possible desktop targets. Choose a desktop that you will activate or 
“switch to” with the hot key you assigned.

• “Next desktop” switches the display to the next desktop.
• “Previous desktop” switches the display to the previous desktop.
• “Show nView task switcher”
• “Toggle NVKeystone mode” toggles the keystone mode between off, on, 

and adjust. 
Note: NVKeystone must be enabled (checked) on the Tools panel for this hot 

key to have any effect.
• “Show nView options menu” will display the nView options menu for the 

currently active window.
• “Switch to next display device” switches your display card’s output to the 

next display output that is connected. 
Note: This hot key only works when your display card is running in single-

display mode.
• “Toggle Clone mode” will turn on and off Clone mode on your display card.

Note: This hot key is only available with Windows XP and only works when 
you are in single-display or nView Clone mode.
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Adding a Hot Key
Note: Only one action can be linked to a hot key. (If you attempt to add an 

action to a hot key that is already defined, an error message appears.) 
However, more than one hot key can be assigned to the same action.

To add a hot key, follow these steps:
1 From the Hot Keys panel, click Add. A properties dialog box appears (Figure 

10.2) that lets you set the “hot key” keystroke and add any additional 
information the hot key needs to operate. 

Figure 10.2 Hot Keys Properties Dialog Box 

• Hot key stroke: This text box lets you select the key or combination of keys 
you want to use to perform the selected action.
To use the text box, follow these steps:
a Click in the Hot Key stroke text box to display your cursor.
b Press the key or keys you want to use for the selection action. For 

example, if you press the Ctrl key followed by the G key, Ctrl + G 
appears in the text box.

• Properties: Hot keys for certain actions require additional information to be 
entered in order to operate. 

When these types of hot keys require additional information, the 
information is requested in this “Properties” dialog box. The information 
requested can be a display, desktop, profile, or an application designation. 
In the first three cases, a list of numbered display devices, named 
desktops, or named profiles appear from which you can select your choice.
If Desktop Manager requires an application input (e.g., for the “Run 
application” hot key action listed in “Selecting an Action” on page 117), a 
Browse button appears allowing you to browse for the application.
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Also see “Examples of Actions Requiring Additional Information” on 
page 120.

2 Click OK when you’ve entered the key strokes. The selected hot key action 
and keystroke combination are added to the Active Hot Keys list. Once a hot 
key is added, it is active and available for use. 

Examples of Actions Requiring Additional Information

“Move window to monitor…” 
An example is the “Move window to monitor…” action. Before you can add a 
hot key for this action, you must use the properties dialog box (Figure 10.3) to 
enter the monitor (display) on which you want to move a window when you 
press the assigned hot key.
Figure 10.3 Hot Keys Properties Dialog Box: for “Move window to monitor…” Action 

“Show Color-Keyed window”
Another example is “Show Color Keyed window”. Before a hot key can be 
added for this action, you must use the Hot Keys Properties dialog box to enter 
additional information. 
To assign this action to a hot key, follow these steps:

1 Confirm that the “Enable Window Color Keying” option is enabled on the 
Effects panel but the “Automatically assign colors to windows” option is 
disabled (unchecked). See “Enable Windows Color Keying” on page 98 for 
further information.

2 Set up a color for a particular application in the Individual Application 
Settings dialog box, as explained in Chapter 11, “Individual Settings” on 
page 132 and Figure 11.7.
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3 Then, set up the “Show Color Keyed window” hot key for the corresponding 
color by following these steps:
a Click to select one of the listed colors (Figure 10.4).
b Edit the color as explained in “Using the Color Key table” on page 99 in 

Chapter 8.
c Click Apply to add the hot key for this action.
When the application is open and you press the assigned hot key, the 
application becomes “Visible on all desktops” so that you can see it on the 
active desktop (even if it is not on the active desktop) and is maximized. 

Figure 10.4 Hot Keys Properties Dialog Box: for “Show Color-Keyed window” Action 

Removing a Hot Key
The Remove option removes the selected hot key from the Active Hot Keys list. 
Once a hot key is removed, it is no longer active or available for use.

Removing All Hot Keys
The Remove All option removes all hot keys from the Active Hot Keys list. 
Once the hot keys are removed, they are no longer active or available for use.

Active Hot Keys List
The Active Hot Keys list box displays a list of hot keys that have been assigned 
and are currently active. Figure 10.5 shows parts of an Active Hot Keys list.
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The Active Hot Keys list box displays the hot key itself (for example., Ctrl + 
G), the hot key action (for example, “Gather all windows to Mon1”), and then 
any further information for that hot key, such as Properties and Application 
Name information, if applicable. 
Note: Use the scroll bar at the bottom of this list box to scroll to the right to see 

all the information columns for a hot key.
Figure 10.5 nView Desktop Manager Properties: Active Hot Keys List 

Active Hot Keys List
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C H A P T E R

USING THE USER INTERFACE OPTIONS
This chapter contains the following major sections:
• “About User Interface Options” on page 123
• “Accessing the User Interface Tab” on page 124
• “General Options” on page 125
• “Windows and Applications Options” on page 125
• “Multiple Desktops Options” on page 136

About User Interface Options
The User Interface options let you control the nView Desktop Manager user 
interface and how it is applied to windows. 
For example, using the User Interface options, you can control the following:
• Addition of button features to your Windows application title bars
• Availability of options on the nView options menu.
• How nView notifies you of changes in your desktop state 
• How nView Desktop Manager is displayed on the Windows desktop
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Accessing the User Interface Tab
To access the Desktop Manager User Interface tab, follow these steps: 
1 Open the nView Desktop Manager properties panel.

(If you need help accessing the nView Desktop Manager properties panel, 
see “Info Panel: Accessing and Enabling nView Desktop Manager 
Properties” on page 60.)

2 Click the Info tab, if you are not already there.
3 Click the check box Enable nView Desktop Manager to enable the option.
4 Click Show Advanced nView Controls to enable the option.
5 Click Apply and then click the User Interface tab.
Figure 11.1 nView Desktop Manager Properties: User Interface Panel

.

User Interface
 panel
 
 

User Interface tab

Click nView Menu Options
to open the nView Menu
Options dialog box.
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General Options

Enable nView Options in Desktop Right-click Menu
Default: Option is enabled (checked). It is recommended that you keep this 
option enabled.
This option controls whether the nView Properties and nView Desktop menu 
choices appear in your Windows desktop “right-click” menu. 
To disable this menu choice, uncheck the checkbox. 

Show Notification Messages on Taskbar 
Default: Option is disabled (unchecked).
This option controls whether a balloon help notification message is displayed on 
the taskbar when a major change in the nView desktop state occurs. 
For example, transparent windows are not compatible with Direct3D 
applications and must be disabled when a Direct3D application starts. If 
notification messages are enabled, then if a Direct3D application starts and 
nView Desktop Manager needs to turn off transparency, a message will pop up 
informing you of this change.

Enable nView Task Switcher 
When this option is enabled, nView adds a desktop switcher in addition to the 
standard application tab switcher. 
By default, this additional “switch desktop” functionality is accessed through a 
Alt-~ keystroke combination which you can change through options in the Hot 
Keys panel. See “Using Hot Keys” on page 115.

Windows and Applications Options

About the nView Button Bar on an Application Title Bar
Enabling options (discussed in the next sections) allows nView Desktop 
Manager to add a nView button bar (Figure 11.2) to all windows in the system 
to allow for easy access to nView Desktop Manager features including the 
following:
• the nView options menu
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• a windows minimization (collapse to title bar) button and 
• desktop/monitor maximizing commands (max to desktop, max to monitor).
In addition to allowing quick access to controls, the nView button bar also 
provides status LEDs on each side. 
• On the left side of the nView button bar is a LED that is either off or red. 

• When the LED is off, this means that the application does not have any 
nView Desktop Manager functions disabled for the window. 

• When the LED is red (shown in Figure 11.2), then certain nView Desktop 
Manager functions for the application window are disabled. 

Note: To determine the Desktop Manager functions that are disabled, open 
the nView options menu for the application and select “About this 
app…”.

• On the right side of the nView button bar is a LED that is either off or white 
(shown in Figure 11.2).
• When LED is off, the window uses global nView settings. 
• When LED is white, the application has individual (application) settings 

defined for it.
Figure 11.2 nView Desktop Manager Button Bar 

nView options menu button

LED indicator = off means
global nView Desktop Manager
settings are in effect.

Red and white LED indicators

“Collapse to title bar” button

XGame

nView button bar
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About the nView Options Menu
You can access Desktop Manager features quickly and easily from any 
application using the nView options menu. Every window has a system menu 
for basic tasks such as moving or resizing the window. Desktop Manager 
extends this menu to add features such as making the window transparent or 
moving the window to another display device or desktop. 
You can also access nView application-specific options from the system menu. 
For example, with certain applications such as Internet Explorer 5.0, you can 
create links between two Internet Explorer windows. 
Note: The features available on the nView Options menu are described in detail 

in “nView Menu: Description of Options” on page 131.
Note: Accessing the nView menu from an application’s title bar is explained in 

the following sections:
• “Add nView Options to System Menus” on page 128
• “Enable nView Menu Options Title Bar Button” on page 129

Enable “Collapse to Title Bar” Button
Default: Option is disabled (unchecked). The button is not added to 
applications’ title bars.
If this option is enabled (checked, as shown in Figure 11.1), the “Collapse to 
title bar” button is added to the application title bar (shown in Figure 11.2).
When you click this button (shown in Figure 11.2), the window shrinks in size 
to just its title bar (or the smallest size possible for the window) as shown in 
Figure 11.3. When you click the button again, the window is restored to its 
former size, also shown in Figure 11.3.
Figure 11.3 Window Appearance Using the “Collapse to Title Bar Button”

 

Clicking the “Collapse to title bar” button causes the application window to only
show its title bar. Clicking the “Collapse to title bar” button again causes the application

 

XGame

window to restore to its original size. 
XGame
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Add nView Options to System Menus 
Default: Option is enabled (checked).
To enable the “nView options” menu item for each of your applications, follow 
these steps:
1 From the User Interface tab, click the check box Add nView options to 

system Menus to add the nView options to every application’s system menu.
2 Click Apply. You can now use one of two methods to display the nView 

options menu:
• Right click an application’s title bar and click the nView options menu 

item (Figure 11.4) or
• Right click the application icon in the Windows task bar and click nView 

options (Figure 11.4).
Figure 11.4 Using “nView Options” to Access the nView Desktop Manager Options 

Menu

 to display the nView Desktop Manager options menu.
Click nView Options from the application’s title bar as another way 

Right click the task bar

XGame

and click nView Options to display the 
nView Desktop Manager options menu. 

XGame

nView Options

nView OptionsXGame
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Enable nView Menu Options Title Bar Button
1 To enable this option, click to check the Enable nView menu options title 

bar button check box. 
When you enable this option, every application window’s title bar will 
contain an nView Desktop Manager options menu button, as shown in Figure 
11.5. 

2 Click the nView options menu button from the application’s title bar to 
display the nView options menu (Figure 11.5).

Figure 11.5 Accessing the nView Desktop Manager Options Menu Using the nView 
Options Menu Button 

Note: When you disable (uncheck) this option, the nView Desktop Manager 
menu button is not displayed in the title bar of applications. In this case, if 
you still need to access the nView options, you can use the nView 
Options title bar option to access the nView options, only if you enabled 
this feature on your User Interface tab.

nView Menu Options 
nView Desktop Manager can perform a variety of operations on windows in the 
system. You can access this functionality through an nView options menu, as 
explained in the earlier sections. 
Figure 11.6 shows the dialog box that appears when you click nView Menu 
Options. From this dialog box, you can change the nView Desktop Manager 
options that you want to display in the nView options menu. In this way, you 

Click the nView options menu button from the application’s title bar to
display the nView options menu.

XGame
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can customize your nView options menu to only show those features that you 
want to use. 
The options that appear in this dialog box correspond to those available from the 
nView options menu that’s available from your application, as shown in Figure 
11.4 and Figure 11.5. 
If you do not want to have all options available, enable/disable (check/uncheck) 
one or more options, as needed.
Note: Once you disable (uncheck) an option, you will no longer see the option 

in the nView Options submenu for that application.
Figure 11.6 nView Menu Options Dialog Box

Enable or disable one or more of the following options by clicking the check 
box next to each option to insert or remove the check mark.
Note: For detailed descriptions of each of these options, see “nView Menu 

Options” on page 129.
• Maximize to desktop
• Send windows to monitor n
• Send application to monitor n
• Send windows to desktop n
• Send application to desktop n
• Transparent
• Always on top
• Visible on all desktops. 
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• Collapse to this desktop 
• Individual settings
Add all: Click this option if you want to enable all of the above options.
Remove all: Click this option if you want to disable all of the above options.
Add all DTM: Click this option if you want to add only the multiple desktop-
specific options.
Remove all DTM: Click this option if you want to remove only the multiple 
desktop-specific options.s

nView Menu: Description of Options
This section explains the nView options that are available from an application’s 
nView options menu (as shown in Figure 11.4 and Figure 11.5) and part of the 
configurable nView Menu Options dialog box (Figure 11.6).

Maximize to Monitor/Desktop 
This option performs the same action as the max/restore title bar option that you 
can add as explained earlier in “Show full-desktop maximize option on title bar” 
on page 93. This option maximizes the application window to the current 
display or to the entire desktop; depending on whether you are running in 
nView Dualview or Span mode. 

Send window to. . . 
• Monitor n: A pop-up menu displays the number (n) of active display devices 

in your setup. Select a display device number, which will represent the 
display to which you want the window to move.

• Desktop n: A pop-up menu displays each defined and active desktop name, 
represented by n, including selections for the default and current desktop. 
Select a desktop. The active window will be sent that desktop.

Send application to . . .
• Monitor n: A pop-up menu displays the number (n) of active display devices 

in your setup. Select a monitor number, which will represent the monitor on 
which you want the application to move.

• Desktop n: A pop-up menu displays each defined and active desktop name, 
represented by n, including selections for the default and current desktop. 
Select a desktop. The application will be sent to that desktop. For an 
application that has more than one window (e.g., Microsoft Outlook), every 
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owned window of the active window (or active window parent) is moved to 
the selected desktop or monitor. 

Transparent (alpha blended) 
Click this check box to toggle transparency on/off for the window. 

Always on top
Click “Always on top” to toggle the option on/off for the window. 
When a window is marked as being always on top, it will always be placed in 
front of any other window. So you can use this settings on windows that you 
don’t want to appear behind or obscured by other windows. 
If two windows have the “Always on top” enabled and they are dragged on top 
of one another, then the last active window is placed in the top position.

Visible on all desktops 
Click Visible on all desktops to toggle the visibility (on/off) of the window on 
all desktops.
Enabling this option causes the window to appear on all desktops. 

Collapse to desktop 
Note: This option is only available if the application has the Visible on all 

desktops option enabled.
Enabling “Collapse to desktop” disables the “Visible on all desktops” option 
and moves the active application window to the current desktop. 

Individual Settings
Note: In order to see the Individual Settings option enabled on the nView 

Options menu on an application’s title bar, you need to have checked 
(enabled) the Individual Settings option in the nView Menu Options 
dialog box, as explained in “nView Menu Options” on page 129 and 
shown in Figure 11.6.

• Enable lets you turn on/off the individual settings for the application without 
losing those settings.

• Edit: To edit individual settings for an application, select Individual 
Settings > Edit on an application’s nView option menu.
Note: To set up individual settings for an application, click Individual 

Settings from the Applications panel. For further details, see 
“Individual Application Settings” on page 169.
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When you choose to set up individual settings for an application, the 
Individual Application Settings dialog box appears (Figure 11.7). From this 
dialog box, you can set up both individual window settings as well as launch 
settings for the application.
Each window management or dialog box management setting can have one 
of three states:

• On means that the feature is always enabled for this application and may be 
represented by a solid colored square, a check mark (as shown in the example 
in Figure 11.7) or other indicator, depending on the application.

• Off means that the feature is always disabled for this application and is 
always represented by an empty square; unchecked.

• Global means that the application uses the standard nView Desktop Manager 
settings for the feature and may be represented by a check mark, solid 
colored square (as shown in the example in Figure 11.7) or other indicator, 
depending on the application.

Note: The Allow transparency and draw at n% option is simply an on/off 
setting that either enables or disables transparency for the application and 
sets an individual transparency level to be used for the application during 
transparent operations.

Figure 11.7 Individual Application Settings Dialog Box
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Individual Settings: Clear all
When you click Clear all, a message is displayed.
Click Yes only if you want to erase all individual settings that Desktop Manager 
may have stored for the application. Otherwise, click No.

Individual Settings: Other Methods of Clearing 
Other ways to clear all Individual Settings for an application are the following:
• Load a profile, which resets your application database. 
• Use the Remove option on the nView Desktop Manager Properties 

Application panel. (See “Managing Applications: For Advanced Users” on 
page 165.)

Menu Options
When you click Menu Options, the nView Menu Options dialog box (Figure 
11.6) opens. 
See “nView Menu Options” on page 129 and “nView Menu: Description of 
Options” on page 131 for details.

About this app… 
This nView menu option appear only if an nView Desktop Manager function is 
disabled for the application. 
Note: Selecting this option will open a dialog box that will describe the nView 

Desktop Manager feature that is disabled.

Application-specific nView Menu Options
In addition the standard nView menu options described above, certain 
applications have custom features available for them on the nView options 
menu. Note that when an application has special nView features, the “About 
this app…” option will be displayed on the nView options menu and will 
provide a brief description as to how to use the feature.
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Internet Explorer Options
Note: You must have installed Internet Explorer 6.0 (at minimum) to access the 

nView Desktop Manager-based Internet Explorer option explained in this 
section.

nView Options adds a new menu item called Open link on monitor n (Figure 
11.8) on the Internet Explorer 6.0 browser, where n represents the monitor 
(display device) number. For example, “1” is the only choice when only one 
display device is attached; 1 and 2 are choices when two display devices are 
attached; 1, 2, and 3 are choices when three display devices are attached, and so 
on.
Once you set this option on a primary Internet Explorer window, as shown in 
the example in Figure 11.8, when you Ctrl-left click or double right-click any 
link from this primary window, the browser window for that link opens on the 
display device you selected with the “Open link on monitor” option.
Figure 11.8 nView Options for Internet Explorer (6.0 or later version)

PowerPoint Options
The nView Desktop Manager options menu adds a new menu item “Show 
slideshow on monitor n” on Microsoft PowerPoint 2000 and PowerPoint 2002, 
where n represents the monitor (display device) number. Once you select a 
monitor to show slide shows on, future slide shows started from Microsoft 
PowerPoint will be shown on that monitor.
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Multiple Desktops Options
Note: For detailed information on desktops, see “Managing Desktops” on 

page 138.

Show Desktop Name When Switching 
Default: Option is disabled (unchecked).
If this option is enabled, when you switch desktops, the name of the desktop to 
which you switched will be shown for approximately two (2) seconds on every 
display device in your setup; then the desktop name will fade out. 
Note: In Span modes (and Multiview mode in Windows NT 4.0), the desktop 

name is only shown on one display.

Enable Desktop Explorer Shell Extension 
Default: Option is disabled (unchecked).
When this option is enabled, you can view desktops in the Windows Explorer 
folder tree.
1 Enable (check) this option to add the Desktop Explorer node to your 

Windows Explorer.
2 Click Apply for the setting to take effect. A prompt appears asking you to log 

off for the change to take effect.
3 Click Yes to log off for the change to take effect, or No to ignore your 

change.
If you just enabled the Desktop Manager Explorer extension, once you log 
back in, it will be visible in your Windows Explorer window. A sample 
Desktop Explorer extension is shown in Figure 11.9.
If you disabled the Desktop Manager Explorer extension, once you log back 
in, it will be removed from your Windows Explorer window

Note: The Desktop Explorer requires an installed version 6.0 or later of Internet 
Explorer. Note that while Internet Explorer 6.0 must be installed to use 
the Desktop Explorer, you can still use other web browsers for browsing 
the web.

Note: For details on using the Desktop Explorer, see “Using Desktop Explorer” 
on page 147 in Chapter 12, “Using the Desktops Tab”.
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Figure 11.9 Desktop Explorer Nodes in Windows Explorer

Note: For details on using the Desktop Explorer, see “Using Desktop Explorer” 
on page 147 in Chapter 12, “Using the Desktops Tab”.

Desktop

 (child nodes)
Explorer
Desktop

 
Explorer
(parent node)
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C H A P T E R

MANAGING DESKTOPS
The following major topics are discussed in this chapter:
• “About Desktops Options” on page 138
• “Accessing the Desktops Tab” on page 139
• “Notes Before You Begin” on page 140
• “Desktops List” on page 140
• “Creating Desktops” on page 141
• “Activating or Switching Desktops” on page 142
• “Renaming Desktops” on page 144
• “Removing Desktops” on page 144
• “Properties: Changing Wallpaper and Desktop Icons” on page 144
• “Using Desktop Explorer” on page 147
• “Advanced User Options” on page 155

About Desktops Options
You can use the Desktop Manager “Desktops” tab to create and configure up to 
32 different “virtual” desktops whether you are using a single monitor or 
multiple monitors. 
If you are using a single monitor, you can create a lot of space by distributing 
one or more applications among different desktops to prevent application clutter 
on your window. Desktop Manager reduces your desktop clutter by letting you 
easily move applications to other desktops thus avoiding the need to open/close 
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or minimize/maximize applications in order to navigate between them. So, 
window clutter is reduced without compromising performance or using extra 
keystrokes.
You can assign customizable names to desktops you create and easily switch 
between desktops using assigned hot keys, the Windows Explorer Desktops 
extension, or even the NVIDIA Media Center icon, as explained later in this 
chapter. 
A variety of methods to create, customize, manage, rename, remove, and switch 
between multiple desktops, as well as easily move applications from one 
desktop to another are discussed in this chapter.

Accessing the Desktops Tab
To access the Desktop Manager Desktops panel, follow these steps: 
1 Open the Desktop Manager properties panel. (If you need help accessing the 

nView Desktop Manager Properties panel, see “Info Panel: Accessing and 
Enabling nView Desktop Manager Properties” on page 60.)

2 Click the Info tab, if you are not already there.
3 Click the check box Enable nView Desktop Manager to enable the option.
4 Click Show Advanced nView Controls to enable the option.
5 Click Apply, then click the Desktops tab.
Figure 12.1 nView Desktop Manager Properties: Desktops Panel

List of
desktops
are displayed
here.

Desktops tab

Desktops panel
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Notes Before You Begin
• Desktop options Add, Properties, Rename, and Remove take immediate 

effect when clicked.
• Each desktop is identified by a name and can have optional customizations, 

such as independent backgrounds or icons that identify the desktop in menus 
and in the Desktop Explorer shell extension.

• Windows Control Panel-based nView (Desktop Manager) Properties, 
command prompt windows, and modal dialog boxes are visible on all 
desktops. All other applications, by default, launch only on the active desktop 
unless you have set up individual settings for the application.

• nView does not support different resolutions per desktop. All desktops are 
automatically set at the same resolution.

• The type of background (wallpaper) selected for your desktop can 
significantly affect how fast you can switch from one desktop to another. For 
further details, see the “Note” in “Properties: Changing Wallpaper and 
Desktop Icons” on page 144.

Desktops List 
The Desktops list box displays a list of all currently available desktops. 
• Desktop Manager maintains a minimum of one desktop and a maximum of 

32 desktops. By default, there is always one desktop named “Default”; this is 
the desktop on which you start up. 

• The Default desktop is listed first, followed by all other desktops in 
alphabetical order. 

Note: If you disable Desktop Manager, you are returned to the Default desktop 
and all open windows are moved to the Default desktop.
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Creating Desktops
Multiple desktops can be created either from Desktops panel using the “Add” 
option, as explained below, or the Explorer shell extension. 
Each desktop can be assigned a unique name.
Note: You cannot add duplicate desktop names.

Using the “Add” Option
1 From the Desktops panel (Figure 12.1), click Add. The “Create a new 

desktop” dialog box prompts for a name of the new desktop (Figure 12.2).
Figure 12.2 nView Desktop Manager Properties: Desktops 

2 If you want to add a Wallpaper background and/or assign the desktop a 
unique “Icon”, go the next steps. Otherwise, click OK to complete adding the 
desktop and return to the Desktops panel where you will see the new desktop 
added to the Desktops list.

3 After you enter the desktop name, optionally, you can assign the desktop a 
Wallpaper background and/or assign the desktop a unique icon.
For details, see “Selecting a Background for the Desktop” on page 146, 
“Selecting Separate Backgrounds Per Display” on page 146, or “Selecting a 
Desktop Icon” on page 147

Click Change Icon to assign the 
desktop a unique icon.

Click Browse to choose a 
Wallpaper background for the 
desktop.

Enter a name of the desktop.
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Note: If you have checked the Enable desktop explorer shell extension option 
in the User Interfaces tab, you can also use the Desktop Explorer node in 
the Windows Explorer to create desktops. See “Creating Desktops from 
Desktop Explorer” on page 148.

Activating or Switching Desktops
From the “Desktops” tab, double-click the desktop you want to activate from 
the list of desktops. 
Note: The type of background (wallpaper) selected for your desktop can 

significantly affect how fast you can switch from one desktop to another 
For further details, see the “Note” in “Properties: Changing Wallpaper and 
Desktop Icons” on page 144.
You can also use a variety of other methods to switch between desktops as 
discussed in these sections:
• “Activating Desktops from the NVIDIA Media Center Icon” on page 142
• “Activating Desktops From the Windows Desktop Properties Menu” on 

page 143
• “Activating Desktops from Desktop Explorer” on page 143
• “Activating Desktops With Hot Keys” on page 144

Activating Desktops from the NVIDIA Media Center Icon
To activate desktops from the NVIDIA Media Center icon, follow these steps:
Figure 12.3 NVIDIA Media Center Icon

1 Right click the Media Center icon from the Windows taskbar, choose 
Desktop Manager > nView Desktops to display the list of your desktops. 
Figure 12.4 shows an example of a list of desktops.
Note: If nView Desktop Manager is disabled, you cannot access the nView 

Desktops option. In this case, right click the Media Center icon from 
the Windows taskbar, click Desktop Manager > Enable nView. 
Again, right click the Media Center icon from the Windows taskbar, 
then click nView Desktops.

2 Choose the desktop you want to activate.
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Figure 12.4 Accessing Desktops Through the Media Center Icon

Activating Desktops From the Windows Desktop Properties 
Menu
1 Confirm that Desktop Manager is enabled. 
2 Right click from your Windows desktop to display the properties menu.
3 Choose nView Desktops to view a list of your desktops. 

Figure 12.5 shows a sample list of desktops from the desktop properties 
menu.

Figure 12.5 Accessing Desktops From the Properties Menu

4 Choose the desktop you want to activate.

Activating Desktops from Desktop Explorer 
See “Renaming, Deleting, and Activating Desktops from Desktop Explorer” on 
page 149.

Activating Desktops With Hot Keys
See “Using Hot Keys” on page 115.
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Renaming Desktops
Click Rename to rename the selected desktop from a text-input dialog box 
where you can type in a new name for the selected desktop. 
Note: You cannot rename the Default desktop.
You can perform the same function from the Desktop Explorer; see “Renaming, 
Deleting, and Activating Desktops from Desktop Explorer” on page 149.

Removing Desktops
Click Remove to remove the selected desktop from the list. 
Once you delete a desktop, it is removed from the list of desktops. The 
applications on the deleted desktop now move to the Default desktop.
Note: You cannot remove the startup (or Default) desktop.
You can perform the same function from the Desktop Explorer; see “Renaming, 
Deleting, and Activating Desktops from Desktop Explorer” on page 149.

Properties: Changing Wallpaper and Desktop Icons 
The Properties option lets you change the background of the selected desktop 
and assign an icon to represent the desktop.
1 From the Desktops panel, select the desktop for which you want to change 

the background and/or icon.
2 Click Properties to open a dialog box, which allows you to set the 

background wallpaper and icon. 
From this dialog box you can browse for different Wallpapers (graphics 
files), set the Wallpaper style (tiled, centered, stretched) or set the desktop 
icon.
Figure 12.6 shows the settings for a single-display configuration. Figure 12.7 
shows the settings for a multi-display configuration where you can change 
the wallpaper per monitor.
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Figure 12.6 Desktop Properties: Changing Desktop Wallpaper (single-display)

Figure 12.7 Desktop Properties: Changing Desktop Wallpaper (multi-display)

 

Wallpaper
options

Multi-display
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Selecting a Background for the Desktop
1 To assign a background to the desktop, click Browse.
2 Select a graphics file to use.
Note: The type of background (wallpaper) you select for your desktop can 

significantly affect how quickly you can switch from one desktop to 
another. Desktop switching performance from fastest to slowest based on 
types of desktop backgrounds is listed below.

3 From the drop-down list, click Stretch, Tile, or Center, depending on how 
you want the background to be displayed.
The background you select is immediately reflected in the monitor image in 
the dialog box, as shown in Figure 12.6.
Notice that the background change takes effect immediately if you are 
modifying your current desktop. If you are modifying a different desktop, the 
change is applied the next time you switch to that desktop. 

4 If you want to completely remove the background, click Clear.
5 Click OK to return to the Desktops panel, or continue to the next section if 

you want to set, change, or remove the icon representation of your desktop.

Selecting Separate Backgrounds Per Display
To select different Wallpapers per display in a multi-display setup, follow these 
steps:
1 Click the Allow different Wallpaper per monitor option to enable (check) 

it and click Apply.
2 As shown in Figure 12.7, click the monitor image (1 or 2) for which you want 

to change the Wallpaper, click Browse and proceed according to the steps 
shown in the previous section. 

3 To change the Wallpaper for the second display, repeat the previous step.

Type of Desktop Background Fastest to Slowest Desktop 
Switching Speed

None Fastest
Bitmap Faster
Active desktop bitmap Fast
Active desktop .JPEG file Slower
Active desktop .HTML Slowest
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Selecting a Desktop Icon
To assign an icon to a desktop, follow these steps:
1 Click Change Icon.
2 Select a graphics file to use. 

Notice that the selected icon is immediately reflected by the icon image, as 
shown in the example in Figure 12.6.

3 If you want to completely remove the icon, click Clear.
4 Click OK to return to the Desktops panel.

Using Desktop Explorer 
Note: Read this section only if you have checked the Enable desktop explorer 

shell extension options on the User Interface panel, as explained in 
“Enable Desktop Explorer Shell Extension” on page 136.

A Windows Explorer extension provides a visual desktop browser. Activating 
the Enable desktop explorer shell extension option adds a new Desktop 
Explorer node in the Windows Explorer tree (Figure 12.8), with each defined 
desktop being represented as a child node (with its name and icon) of the 
Desktop Explorer parent node. 
When a desktop node is selected, the content pane can displays the applications 
present. To see the graphical representation of the desktop itself, you need to 
select the Desktop Explorer (parent node).
The active applications are displayed as leaves of each corresponding desktop 
node, allowing drag and drop and other common Explorer functionality. 
The following topics are discussed in this section:
• “Creating Desktops from Desktop Explorer” on page 148
• “Renaming, Deleting, and Activating Desktops from Desktop Explorer” on 

page 149
• “Enhancing the Desktop Explorer “Thumbnails” View” on page 150
• “Using the Thumbnail Styles” on page 150
• “Moving Applications Between Desktops or to a New Desktop” on page 151
• “Accessing Other Application Settings from Desktop Explorer” on page 152
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Creating Desktops from Desktop Explorer
To create and add a desktop using the Desktop Explorer, follow these steps:
1 Right click Desktop Explorer in the Folders list, as shown in Figure 12.8
Figure 12.8 Desktop Explorer: Main Pop-up Menu

2 Click New Desktop to display a dialog box to enter the desktop name.
3 Type the new desktop name (Figure 12.9) and click OK. The new desktop 

appears as a new desktop under Desktop Explorer.
Figure 12.9 Entering a Desktop Name 

Desktop Explorer
“main” pop-up
menu
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Renaming, Deleting, and Activating Desktops from 
Desktop Explorer
Using the Desktop Explorer, you can also rename, delete, and activate (switch 
to) a selected desktop.
1 Right click the Desktop name in the Explorer window to display a pop-up 

properties menu, as shown in Figure 12.10.
Figure 12.10Desktop Explorer: Desktop Pop-up Menu

2 Click one of these options:
• Activate: This option immediately switches you over to the selected 

desktop. 
• Delete lets you delete the selected desktop.
• Rename lets you rename (in edit mode) the desktop name.

Under Windows NT 4.0, clicking Rename displays a Rename Desktop 
dialog box in which you can enter a desktop name. Click OK when you 
are done and the new name replaces the old one in the Explorer window. 

• Properties: Click this option to open the Desktops panel.

 
 “
pop-up menu

Desktop Explorer “desktop”
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Enhancing the Desktop Explorer “Thumbnails” View 
From the Desktop Explorer window, click the View menu to see a variety of 
styles you can choose to view your folders, files, and desktops in the content 
pane of the Explorer window. These styles include Lists, Icons, Details, and 
Thumbnails.
Note: In addition to the basic views offered by Windows Explorer, if you 

choose the Thumbnails view from the Desktop Explorer View menu, 
nView Desktop Manager provides a number of Thumbnail styles you can 
choose to display the desktops you have created.

Thumbnail style choices are:
• Screenshot shows an actual image of the desktop including wallpaper and 

windows. Note that this style requires the most processing power. Also note 
that the image displayed is a snapshot of the desktop when you switched 
from it is only updated when you switch from it, it does not dynamically 
update.

• Geometry shows the desktop wallpaper along with a wire frame view of the 
windows on the desktop. This thumbnail style dynamically updates as 
windows are opened and closed on the desktop.

• Wallpaper shows the desktop wallpaper only per desktop.
• Disabled shows the desktop icons only.

Using the Thumbnail Styles
To use the Thumbnail styles for your desktops, follow these steps:
1 From the Desktop Explorer window, click the View menu and then the 

Thumbnails option to enable the Thumbnails option (if it isn’t already 
enabled).

2 Click the icon labeled Desktop Explorer in the folder tree of your Explorer 
window to expand the folder so that you can view your desktops in the 
contents pane.

3 Then right click on the desktop for which you want to configure Thumbnail 
styles. A pop-up menu appears as shown in (Figure 12.10).

4 Click Thumbnails and then select one of these styles: Disabled, Wallpaper, 
Screenshot, or Geometry (Figure 12.10).
Note: Not all thumbnail styles are supported by all operating systems. 

However, Windows XP supports all styles.
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Figure 12.11Desktop Explorer: nView Desktop Thumbnails Styles 

Moving Applications Between Desktops or to a New 
Desktop 
Note: If you enabled adding nView options. . on the User Interface panel, you 

can also move applications between desktops using the application’s 
nView menu options. See “nView Menu Options” on page 129 and 
“nView Menu: Description of Options” on page 131 for details.

You can use any of the following methods to “move” or “add” applications 
from one desktop to another:
• To move applications from one desktop to another, you can use your mouse 

to drag and drop applications from one desktop to another.
• To move or add application between desktops, you can highlight an 

application listed in a desktop and right click to display a properties menu, as 
shown in Figure 12.12. Then follow these steps:
a Click Send to (to move) or Add to (to add) followed by an existing 

desktop to which you want to move the application or add the application. 
The application will then appear under the desktop you selected.

b If you want to create a new desktop on which you want to place the 
application, click New Desktop, enter the name of the new desktop in the 
dialog box that appears, and click OK. The application will appear under 
the new desktop.
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Figure 12.12 Desktop Explorer: “Send to Desktop n” Application Settings

Accessing Other Application Settings from Desktop 
Explorer
Using the Desktop Explorer, you can access a few application-specific settings 
as explained below.
Note: If you enabled adding nView options. . on the User Interface panel, you 

can also access these application-specific options using the application’s 
nView menu options. See “nView Menu Options” on page 129 and 
“nView Menu: Description of Options” on page 131 for details.

• Visible on all desktops
To access this option, follow these steps:
a Right click an application in a desktop to display a properties menu, as 

shown in Figure 12.12. 
a Then click Visible on all desktops to check the option and enable it. 
a Notice that the application now appears under each of your desktops, as 

shown in Figure 12.13.
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Figure 12.13Desktop Explorer: After Setting “Visible on all desktops” 

• Collapse to <desktop name>
Once you enable the Visible on all desktops option for an application, you 
can undo the process by limiting the availability of the application to only 
one desktops. To do so, follow these steps:
a Right click the instance of the application that appears in the desktop in 

which you want the application to remain.
a From the properties menu that appears, click Collapse to <desktop 

name>, as shown in Figure 12.14.
a Notice that the application is removed from all desktops except the one 

under which you wanted the application to remain, as shown in Figure 
12.15Figure 12.15.

• Properties 
Click Properties (Figure 12.14) to open the Applications panel. For details 
on using the Applications settings, see “Managing Applications: For 
Advanced Users” on page 165.

Application is
“Visible on all
desktops”
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Figure 12.14Desktop Explorer: “Collapse to Desktop n” Application Setting

Figure 12.15Desktop Explorer: After Setting “Collapse to Desktop n”

Click “Collapse to
desktop n” to remove
the application from
other desktops.

Click Properties to open the 
Applications panel.

Application “collapsed”
to selected desktop and
removed from other
desktops.
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Advanced User Options

Add to Desktop 
Using the Add to desktop option, you can place an application on any number 
or subset of desktops. 
For example, if you had four desktops named “Default”, “Desk2”, “Desk3”, 
and “Desk4” and you had an application on Default, you could add it to Desk3. 
After adding the application to Desk3, the application would exist on Default 
and Desk3 but not on Desk2 and Desk4. 

Remove from Desktop 
Using the Remove from desktop option, you can remove an application from 
an individual desktop. 
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C H A P T E R

USING TOOLS OPTIONS
This chapter contains the following major sections:
• “About Tools Options” on page 157
• “Accessing the Tools Tab” on page 157
• “Display Quality” on page 158
• “Windows Utilities” on page 160
• “NVKeystone” on page 160

About Tools Options
The nView Desktop Manager Tools panel offers several miscellaneous tools 
that can help you be more productive. Included features are NVKeystone to 
correct for display keystoning, a flat panel calibration screen used to optimize 
the calibration of your analog flat panels, and several windows utilities that can 
automatically correct for improper display settings when they occur.

Accessing the Tools Tab
To access the nView Desktop Manager Tools panel, follow these steps: 
1 Open the nView Desktop Manager properties panel.

(If you need help accessing the nView Desktop Manager tabs, see “Info 
Panel: Accessing and Enabling nView Desktop Manager Properties” on 
page 60.)

2 Click the Info tab, if you are not already there.
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3 Click the check box Enable nView Desktop Manager to enable the option.
4 Click Show Advanced nView Controls to enable the option.
5 Click Apply, then click the Tools tab.
Figure 13.1 nView Desktop Manager Properties: Tools Panel

Display Quality
The NVKeystone options in the Display Quality section (Figure 13.1) lets you 
place your 2D windows desktop onto a 3D surface, which you can then 
manipulate to compensate for image distortion caused by poor alignment of 
projection screens.
For more information on using NVKeystone, see “NVKeystone” on page 160 
later in this chapter

Enable NVKeystone Display Correction 
Click this check box to enable or disable the anti-keystone feature. 
Note: If this option is disabled, NVKeystone menus and hot keys will not work.

 

Tools panel

Tools tab
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Enable NVKeystone Option in Desktop Menu
Click this check box to place a NVKeystone option in the desktop right-click 
menu (Figure 13.2) for easy access to NVKeystone. 
Note: If you do not enable this option, the NVKeystone option will not be 

placed in the desktop right-click menu. In this case, the only way to turn 
NVKeystone on/off is by using a Hot Key assignment.

For more information on using NVKeystone, see “NVKeystone” on page 160 
later in this chapter.
Figure 13.2 NVKeystone Option in Windows Desktop Properties Menu

Show Flat Panel Calibration Screen
This option (Figure 13.1), when clicked, displays a calibration screen on every 
monitor on the desktop. This calibration screen has been designed to optimize 
calibration of analog flat panels when using auto-calibrate (or auto-sync) 
features available on most flat panels. 
Note: This calibration screen is not needed if you use analog monitors (CRTs).
To use this option, follow these steps:
1 Click the Show Flat Panel Calibration Screen. Each monitor will now 

display the nView calibration screen.
2 For each analog flat panel, select its auto-calibrate or auto-sync function.

Note: This function varies for each flat panel manufacturer.
3 After auto-syncing each flat panel, press any key to close the flat panel 

calibration screens.
Your panels should now be calibrated to their optimum settings.
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Windows Utilities

Automatically Align Displays 
Default: Option is enabled (checked).
Note: This option must be enabled (checked) in order for the two features 

(explained below) to work.
Automatically Align Displays (Figure 13.1) performs two important functions: 
• First, Windows 2000 has several multi-display positioning bugs when using 

more than two displays devices. These bugs include inserting 8-pixel gaps 
between displays or forcing displays into a diagonal arrangement if you 
attempt to stack displays on top of each other on the Display Properties 
Settings panel. 
Note: Enabling this option detects these Windows 2000 bugs and 

automatically fixes them!
• A second function of this feature is that it automatically snaps your display 

devices into alignment if you misalign them on your Display Properties 
Settings panel. 
Note: This “alignment snap” functionality is only applied if your displays are 

within 8 pixels of being aligned.

NVKeystone
NVKeystone is an anti-keystoning tool that allows you to map your entire 
windows desktop onto a 3D surface and then manipulate and “warp” the surface 
to compensate for distortion effects of any surface on which you are displaying.
Because NVKeystone is a 3D application that operates on the entire desktop, it 
takes a great amount of bandwidth to operate. You may notice that your display 
is sluggish or that 3D games run very slowly when NVKeystone is active. 
Note: It is recommended that you disable NVKeystone when you are playing 

games or using a 3D program.

Accessing NVKeystone
You can access NVKeystone using one of two methods:
• From the desktop, right-click to access the Properties menu (must enable the 

option in tools) as shown in Figure 13.2 or 
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• Use a hot key assignment
This section will focus on accessing NVKeystone from the Desktop properties 
menu. 
Note: Using the hot key method is similar to the Desktop Properties method but 

only the hot key method can rotate between three different modes – Off, 
On, and Adjust.

NVKeystone Menu
The NVKeystone menu (Figure 13.2) contains four options – Activate, Adjust, 
Options, and Reset.
• Activate turns NVKeystone on and off.
• Adjust displays the NVKeystone Adjustment Screen. See NVKeystone 

Adjustment Screen in the next section for details.
• Options displays the NVKeystone Options dialog box. See “NVKeystone 

Options” on page 162 for details.
• Reset resets NVKeystone to its default settings; that is, warping is disabled.

NVKeystone Adjustment Screen
The “Adjustment Screen” (Figure 13.3) lets you adjust the warping of the 
display. 
You can grab each of the red “hot spots” on the screen with the mouse and then 
drag it to warp the display. In addition, you can use your arrow keys to perform 
fine adjustments of the corner that you are currently grabbing with your mouse. 
Note: Four options are available within the Adjustment Screen: OK, Cancel, 

Reset and Options.
• OK lets you exit the Adjustment Screen after automatically saving the 

adjustments you have made.
• Cancel lets you exit the Adjustment Screen and discards any adjustments 

you have made. Note that your screen then reverts to its state before you 
opened the Adjustment Screen.

• Reset resets your screen to default settings; i.e., no warping of the display.
• Options displays the NVKeystone Options dialog box. See “NVKeystone 

Options” on page 162 for details.
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Figure 13.3 nView Desktop Manager Properties (Tools): NVKeystone Adjustment 
Screen

NVKeystone Options
From your desktop, right click your mouse to display the properties menu, then 
click NVKeystone > Options to display the NVKeystone options menu (Figure 
13.4). The following options can be set:
• Enable video overlay while NVKeystone is running allows video to play 

back correctly when NVKeystone is active.
Note: It is recommended that this option remain enabled (checked).
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Figure 13.4 nView Desktop Manager Properties (Tools): NVKeystone Options

• Automatically turn NVKeystone off if disabled for more than 30 seconds 
automatically turns off NVKeystone and unloads it from memory if it is 
unused for more than 30 seconds. 

When NVKeystone is not active (i.e., the “Activate” option is not checked in 
the NVKeystone menu), NVKeystone is still present in your computer's 
memory. This allows you to quickly turn on NVKeystone again, if needed.

• Enable NVKeystone display filtering enables antialiased filtering of the 
NVKeystone image.

• Use sticky mouse clicks when editing enables “sticky” mouse clicks for the 
NVKeystone Adjustment Screen. 
Note: “Sticky” mouse click means that you can click once to grab a corner of 

the Adjustment Screen and then click again to release a corner instead 
of having to hold down the mouse button.

• Apply NVKeystone to monitor …lets you to change the display on which 
NVKeystone appears. 
Note: If you are running in nView Span or Clone mode, both displays will 

have NVKeystone applied. However, if you are running in Dualview 
mode, you will have the option to choose a display for NVKeystone.

• Change NVKeystone modes with… lets you change or assign a hot key to 
toggle the NVKeystone mode between off, on, and adjust.
Note: You can perform the same hot key assignment from the Desktop 

Properties Hot Keys tab. See “Using Hot Keys” on page 115.
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C H A P T E R

MANAGING APPLICATIONS:
FOR ADVANCED USERS

This chapter contains the following major sections:
• “Accessing the Applications Tab” on page 165
• “Using the Applications Options” on page 166
• “Adding an Application” on page 168
• “Removing an Application” on page 168
• “Disabling an nView Desktop Manager Function” on page 169
• “Individual Application Settings” on page 169
• “Launch Settings” on page 171

Accessing the Applications Tab
To access the Desktop Manager Applications panel, follow these steps: 
1 Open the Desktop Manager main properties window.

(If you need help accessing the Desktop Manager window, see “Info Panel: 
Accessing and Enabling nView Desktop Manager Properties” on page 60.)

2 Click the Info tab, if you are not already there.
3 Click the check box Enable nView Desktop Manager to enable the option.
4 Click Show Advanced nView Controls to enable the option.
5 Click Apply, then click the Applications tab.
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Figure 14.1 nView Desktop Manager Properties: Applications Panel 

Using the Applications Options
nView Desktop Manager can be customized to function differently for each 
application. You can set up some applications to maximize to the full desktop 
while you can set up others to maximize to a single display. 
You can also configure how an application launches; for example, you can 
choose a Windows application such as Calculator to always launch 
transparently while have Internet Explorer always launch on a specific desktop.
The nView Desktop Manager Applications panel provides a central spot where 
you can set up and edit these individual application settings. The Applications 
panel also allows you to disable nView Desktop Manager functions for each 
application. While NVIDIA tests hundreds of applications for compatibility, 
there may be certain third-party applications that are not compatible with certain 
features, such as Transparency or the nView Desktop Manager menu options. 
Using the Applications panel, you can disable these features for applications 
that are not compatible with these features.
In addition to distinguishing between different applications, nView Desktop 
Manager can also distinguish between different Window Classes. 

Applications
 panel

Applications tab
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Window Class
A Window Class is simply a type of window. Often, Window Classes are 
unique to an application. For example, in nView Desktop Manager, several 
Window Classes are used; for example, a class called “Zoom1” for the Zoom 
window, a class called “Child1” for the little white square inside the Zoom 
window, and so on. 
In addition to classes that are unique to an application, there are certain global 
classes of windows that are used by every application. An example is a dialog 
box that is a global class (the name is #32768 – class names are not always 
intuitive). Using class names, however, allows you to more precisely target 
windows for which you want to disable features. 
For example, the Zoom1 window class can be set up not to support 
Transparency. Therefore, there is no need to turn off Transparency for all 
nView Desktop Manager windows. Also, if another application uses the Zoom1 
window class, the Transparency rule will still operate.
Note: When a Window Class is selected in the list, the Individual Settings 

option is disabled. (Window Classes cannot have Individual Settings 
enabled.) Window classes can only have disabled nView Desktop 
Manager functions.

The Applications panel (Figure 14.1) displays a list of all applications and 
window classes that are set up for Individual Settings and/or have nView 
Desktop Manager functions disabled. Each line in the list box contains a few 
elements. The name of the application or class is listed along with an icon to the 
left. 
• If there is a green checkmark on the icon, this means the application has 

Individual Settings.
• If there is a yellow ! on the icon, this means that some nView Desktop 

Manager functions are disabled.
• If there is a bold red X on the icon, this means that all nView Desktop 

Manager functions are disabled for that application or class.
For example, the list in Figure 14.1shows the following: 
• The CicMarshalWndClass has all nView functions disabled.
• The Notepad application has no special settings.
• The Regedit application has some nView functions disabled.
• My Window Class has no special settings.
• The Explorer application has Individual Settings.
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Note: Below the list box, in the Selected Application’s Settings box, a text 
description of the selected item in the list is also provided. For the 
“regedit” application example, the text box correctly states that regedit 
has no Individual Settings but that some nView Desktop Manager 
functions are disabled for it.

Adding an Application
1 To add an application to the list box, click Add App. . . from the 

Applications panel to display a dialog box (Figure 14.2) where you can 
browse for an application to add to the list box.

2 To add a class to the list box, click Add Class to display a dialog box where 
you can type in a class or use the Class Finder Tool to add a class to the list 
box.

Figure 14.2 nView Desktop Manager Properties (Applications): Add Class 

Note: When you add a class or an application to the list box, you still have not 
set any special settings for it. In this case, the icon (for the class or 
application) will be blank like the Notepad application or My Window 
Class as shown in Figure 14.1 earlier in this chapter. If you close the 
Applications panel now and reopen, these two list elements will be 
removed because they had no special settings applied to them. 

Removing an Application
To remove the application or class from the list and delete any Individual 
Application Settings (Figure 14.4) or disabled function information for the 
application or class, click the Remove option on the Application panel.
Note: To disable all nView individual application settings throughout the 

system for all windows, enable the “Globally disable individual settings 
and state memory” option at the bottom of the Application panel.
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Disabling an nView Desktop Manager Function
To disable an nView Desktop Manager function:
1 First, select the application or class for which you want to disable a function 

by selecting it from the list of applications and classes. If the application or 
class for which you want to disable the function does not appear in the list 
box, add it using the Add Application… or Add Class… option.

2 Next, click the Disable… option to display the Disable nView Functions 
dialog box (Figure 14.3).

Figure 14.3 nView Desktop Manager Properties (Applications): Disable nView 
Desktop Manager Functions

By default, all functions are enabled. You can chose to disable all functions 
(Enable nView Desktop Management) or just a subset of functions from the 
group of check boxes. 
3 Click OK when you have finished selecting functions to disable.

Individual Application Settings
To set up individual application settings for an application, click Individual 
Settings from the Applications panel. 
Note: You can also set up individual application settings using the nView 

options menu. To edit individual settings for an application, select 
Individual Settings > Edit on an application’s nView option menu.

When you select to set up Individual Settings for an application, the 
Individual Application Settings dialog box appears (Figure 14.4).
From this dialog box, you can set up both individual window settings as well as 
launch settings for the application.
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Each window management or dialog management setting can have one of three 
states:
• On means that the feature is always enabled for this application and may be 

represented by a solid colored square, a check mark (as shown in the example 
in Figure 14.4) or other indicator, depending on the application.

• Off means that the feature is always disabled for this application and is 
represented by an empty square - unchecked.

• Global means that the application uses the standard nView Desktop Manager 
settings for the feature and may be represented by a check mark, solid 
colored square (as shown in the example in Figure 14.4) or other indicator, 
depending on the application.

Note: The Allow transparency and draw at n% option is simply an on/off 
setting that either enables or disables transparency for the application and 
sets an individual transparency level to be used for the application during 
transparent operations.

Figure 14.4 nView Desktop Manager Properties (Applications): Individual 
Application Settings
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Launch Settings
Launch settings are only applied when an application is first started. 
• The Transparency, Always on top, and Visible on all desktops can have 

one of three settings:
• On means the setting will always be turned on when the application starts.
• Off means the setting will always be turned off when the application 

starts.
• Last Setting means that when the application is closed, the setting will be 

saved and then restored when the application is opened again. In other 
words, the setting will be remembered.

• Restore window size and position, when checked, will cause nView to store 
the application window’s size and position when it is closed and then restore 
the application to the same size and position when opened again.

• Launch application on desktop lets you to set up a specific desktop to 
launch the application on. You can select a specific desktop on which to 
always launch the application from the drop down list. Two choices are 
always listed: Active and Last. 
• If the Active desktop is chosen (default), the application will launch on 

your currently active desktop regardless of the desktop you are on.
• If the Last desktop is chosen, the desktop on which the application was 

located when it was closed will be remembered and, when the application 
is relaunched, it will open on that stored desktop (the last desktop it was 
closed on).

Note: If an application is set to open up on a desktop different than your current 
desktop, when you launch that application, you will be automatically 
taken to the desktop on which the application launches.
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